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Your success is important to us!

Spider Impact is industry-leading performance management software that

powers data visualization, balanced scorecards, team alignment, business

intelligence, and KPI and initiative management. This comprehensive guide explains

how to use the software, including some of the more advanced functionality.

Although we’re providing this information here as a single user guide, it’s much

better when referenced online. You can see every cross-referenced article in its

most up-to-date form at support.spiderstrategies.com .

To help you discover everything Spider Impact has to offer, we also have free

training videos on our website, and we’ve put together several “what is” guides to

explain some of the more popular performance management methodologies. We

even host free monthly webinars to walk you through new features and best

practices.

If you want to maximize your return on investment, we offer paid formal training

courses and dedicated consulting engagements. Most of our customers prefer the

flexibility of contracting for remote (web-based) assistance, but we also have on-

site services available if they’re a better match for your requirements.

https://support.spiderstrategies.com/
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Personal

Home Section

Welcome

When you first log into Spider Impact you see the Welcome screen in the Home

section.

This gives you a quick overview of your most important information.

�. The welcome message can be edited by an administrator and can contain a

logo and videos.

�. You'll see your most recent alerts here. There's also a link that takes you to

the alerts page that we discuss next.

�. You can see the number of KPIs you own and update, as well as any tasks

that are assigned to you. Clicking on one of these rows will take you to that
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page described below.

�. This help link defaults to sending requests to Spider Strategies, but

administrators can change it to send help requests to any email.

Alerts

The Alerts section shows you all of the alerts you've received.

Update KPIs

On the KPI Updates page you can update all of the KPIs that you have been

assigned to as an Updater.
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There are a few extra controls on this page to make it easier to update large

numbers of KPIs.

�. The filter control allows you to filter by organization as well as KPI calendar

period.

�. You can upload a spreadsheet with KPI values rather than typing in the

values by hand.

My KPIs

This shows you all of the KPIs that you have been assigned to as an Owner.
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On the top of the page is a summary of how many KPIs you have of each color. You

can click on each summary box to only show KPIs of that color.

My Tasks

My Tasks is similar to My KPIs, except it shows you all of the tasks from the

Initiatives section that you're an owner of.
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Approve KPIs

The “Require Owner Approval For KPI Value Updates” application configuration

setting defaults to off.

When enabled, all updates to KPIs that have owners will go into an approval

queue. KPI owners will receive an alert that they have values to approve, and they

can visit the Approve KPIs screen in the Home section to do this.
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You can approve or reject all pending updates in your queue by clicking on one of

the “all” buttons on the top of the list and then clicking Save.

You can also select individual updates to be approved or rejected.



USING SPIDER IMPACT 11

If a KPI has no owners, or if its only owner is the person who updated the KPI with

a new value, the update will not go into the approval queue and will instead

appear immediately.
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Bookmarks

Overview

The Bookmarks section is where you organize links to your favorite screens for easy

access. Every user's bookmarks are different, and many people are able to keep an

eye on their organization's performance by just clicking through their bookmarks

every week.

Adding a Bookmark

To create a bookmark, click on the star icon. In this example, we're looking at a

dashboard in the Dashboards section.
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We now see that dashboard in the Bookmarks section.
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Editing Bookmarks

You can rename, reorder, or remove a bookmark by clicking on the Edit tab in the

bookmarks section.
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Importing Data

Simple Value Imports (KPIs and Initiatives)

Overview

This article covers how to create a new KPI or Initiative value import, as well as

how to import data that is already in a specific format. Please see the Advanced

Value Imports (KPIs and Initiatives) article for how to import data in more

advanced formats.

Starting a new Import

You can import KPI and Initiative values directly inside of Spider Impact. Anywhere

you manually update data, there is the ability to import data as well. For example,

on every tab in the Scorecards section there’s an import menu with a KPI values

option

The Initiatives section has a similar button for importing initiative status.

https://support.spiderstrategies.com/hc/en-us/articles/360041613491
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There’s even an import button when updating KPI values in the Home section.
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Simple Imports

When importing KPI and Initiative values, the default option is Simple Import.

Simple import is by far the easiest option and is great when you have data that’s

already in a supported format. Your spreadsheet can have dates in either the

header row or in a column, and there are example files that you can download to

show you exactly what the app is looking for.
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Finally, Spider Impact can easily export your existing KPI data in exactly this

format so you can import it to another organization, or modify your data to be re-

imported. This is covered in the Exporting KPI Value Import File article.

With just a couple clicks you can import data and be on your way.

https://support.spiderstrategies.com/hc/en-us/articles/360041613411
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Advanced Value Imports (KPIs and Initiatives)

Overview

This article covers all of the advanced functionality for importing KPI and Initiative

values. For information about how to start an import, or how to easily import

values that are already in a specific format, please see the Simple Value Imports

(KPIs and Initiatives) article.

Data Source

The first step when importing KPI or Initiative values is to choose what type of

import you want. When you want more powerful data import options, choose

Advanced Import. This turns your value import into a 9-step wizard with full

export, transform, and load (ETL) capabilities.

The first thing you’ll need to do is choose a data source. For example, you can

choose Database...

https://support.spiderstrategies.com/hc/en-us/articles/360050097311
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... and write a SQL query. You can choose any existing database connection, or you

can click "New Connection" to set up a connection to a variety of databases:

Microsoft SQL Server

Oracle

MySQL

SAP HANA

IBM DB2

You can manage all import connections in the administration section.

https://support.spiderstrategies.com/hc/en-us/articles/360041568531
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Or you can choose Spreadsheet...
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... pick one of several ways to get the spreadsheet into Spider Impact...

… and then do any last-minute cleanup. In this example we’re importing from an

Excel spreadsheet, so we can choose a worksheet on top. Many spreadsheets have

header data that you don’t want to import in the first few rows, for example

column labels or a spreadsheet title. If one of these rows contains your column

labels, be sure to flip the switch on that row. You can also use the Ignore

checkboxes to hide irrelevant data.
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Transforming Data

Next is the optional transformation stage. If you want to import your data as-is,

just click next. If you want to change your data before it’s imported, however, click

Add Transformation. This is covered more in-depth in the Transforming Values

While Importing article.

https://support.spiderstrategies.com/hc/en-us/articles/360041132552
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Identifying Fields in Import Data

At this point, it doesn’t matter where your data is coming from, it all looks the

same. Now you’ll need to tell the software where to find the data you want to

import. To do this, just drag and drop the column labels onto the top of each

column. If your columns are named something that Spider Impact recognizes, we’ll

do this for you automatically.
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One of the things you’ll need to tell the software is where to find the dates for the

values. In this example we’ve chosen “dates are in a column” and we’ve matched

the Date label with the date column.
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You can also choose a specific date for all of the values you’re importing.

You can even choose a relative period. In this example we’re importing KPI values

into the current period.
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Finally, for KPI values you can choose “dates are in a header row.” This allows you

to import multiple values for each KPI row.

Identifying Destination KPIs

After you’ve chosen what data you want to import, the next step is choosing

where you want that data to go. Just choose the items you want to import data

into, or choose an item higher in the tree to select every KPI or Initiative below it.
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To see the items that you’ve already selected, just click the Edit KPIs button.
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This will open a second-level dialog where you can view and remove the KPIs that

you’ve selected to import data into.

Mapping Import Data to Destination KPIs

Now it’s time to match the import data with the destination items. We’ll do our

best to automatically choose a matching based on name.
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Saving and Scheduling

Your value import is now ready to run.

If you want, you can also save your import so you can quickly run it again later with

new data. By assigning other users and groups as owners, you can share this

import with other people.
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You can even schedule the import to run on a recurring basis. In this example we’re

going to import a new version of the data every Sunday night.
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You can manage imports and import connections in the Administration section.

https://support.spiderstrategies.com/hc/en-us/articles/360041568531
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Importing Scorecard Items

Users who have permission to modify scorecard structure can now import

scorecard items from a spreadsheet directly inside of Spider Impact. To start, just

click on the “Import Scorecard Items button on any tab in the Scorecards section.

Or, if your organization doesn’t have a scorecard yet, you can click on the “Import

Scorecard Items” button in the navigation pane.
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This opens a dialog where you can upload your spreadsheet. You can also

download an example file showing what your spreadsheet can look like.
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Finally, Spider Impact can easily export existing scorecard items in exactly this

format so you can import it to another organization, or modify your data to be re-

imported. This is covered in the Exporting Scorecard Import File article.

If your columns have the same names as their corresponding scorecard item fields,

the software will automated add the correct labels. Otherwise, you’ll need to drag

and drop the column labels to correctly match the columns.

You can import an entire scorecard, or you can import just a few scorecard items

at a time. In this example the “improve customer satisfaction” objective is selected

when we click the “import scorecard items” button, so everything we import will be

created underneath that.

https://support.spiderstrategies.com/hc/en-us/articles/360041286032
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Importing Data with Zapier

Zapier is a website that allows you to choose from over 5,000 data sources, and

then push your data to Spider Impact. It’s a paid service that allows technical

people to import data from other websites without coding.

Zapier only works with cloud software that has chosen to share their data with

Zapier. Each company creates and maintains their own Zapier integration, and

Zapier acts as a traffic cop, pulling data from one piece of software and pushing it

into another.

Finally, it’s important to note that not every Zapier data source is a great fit for

Spider Impact. That’s because the types of data that you can get depends on

what the owners of that data source have chosen to share with Zapier. For

example, some data sources expose their full historical data, while others only send

information about events as they happen.

Setting up the connection between Zapier and Spider Impact

The first step is to set up a Zapier import connection inside of Spider Impact. Here

we’re clicking “Add Connection” on the Administration > Import Connections page.
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This opens the “Add Zapier Connection” dialog. When Zapier pushes data to

Impact, Impact needs to know where that data should go. That’s what the API Key

here is for. It’s created by Spider Impact to identify the import connection you’re

creating right now.

Zapier is going to need this API Key, so click the “Copy” button to copy it.

Before continuing to the next step in Spider Impact, you’ll need to set up a

connection to Impact in Zapier. Open the My Apps page in Zapier in a new browser

tab and log in. Then click the “Add connection” button.

https://zapier.com/app/connections
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Search for Spider Impact and click on it.

A new window will open. Paste the API Key that you copied from Spider Impact,

and click “Yes, Continue”.
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Zapier will show a “New connection added” success message, but unfortunately it’s

on the top of a “404: Page Not Found” message. Don’t worry, everything is working

correctly. We hope Zapier fixes this bug soon.

You’ve just created the Zapier half of the connection. Now it’s time to go back to

Impact and finish the other half. Click the “I’ve Completed the Instructions Above”

button.
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Finally, give your Zapier connection a name, assign it owners if you want, and click

Done.
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Your new Zapier connection is now shown on the Import Connections screen.

Creating a Zap

Now that both ends of the data connection have been set up, Spider Impact will

start catching any data that Zapier sends it. It’s not a problem that Impact

doesn’t know what to do with the data yet. It’s just going to happily collect data

from Zapier until you create an import to use it.

So, the next step is to create a Zap in Zapier that sends data to Impact. To do this

we’ll open the Zaps page in Zapier and click the “Create Zap” button.

https://zapier.com/app/zaps
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The first part of setting up a new Zap is choosing its trigger. This is the event that

is going to start the process of sending data to Spider Impact. It could be when

something happens in an app, like a new issue being created in a support ticket

system. Or it could be a built-in tool like when a webhook fires. In this example

we’re going to choose for the trigger to happen on a schedule.

We’ll choose to run our Zap every week…
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… on Sunday at midnight.

We’ll now test the trigger…
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… and it works.
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When we click Continue, we move on to the next step in the Zap setup process,

choosing the Action. There are literally thousands of things you can do for an

action, but you’ll often want to choose to get data from an app. In this example

we’ll choose Salesforce.
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There is a list of Events that Salesforce allows us to choose from, and these

options are different for every app. We’ll choose “Find Record(s)” because we want

to get records out of Salesforce.
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Next, we need to authenticate with Salesforce. We’ll choose “Connect a new

account”.
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This opens a new window to connect to Salesforce. We’ll choose our “production”

Salesforce environment, and click “Yes, Continue”.

We’ll log in with our Salesforce credentials…

… and we’ll give Zapier permission to access our data.
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The Salesforce connection window closes, and we’ll click Continue.
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Now we need to set up the Find Record(s) action. Again, this step will be different

for every app. We’ll need to choose which kind of Salesforce objects that we’re

looking for. We’ll choose to get “Account” objects, which are like customer records

in Salesforce.
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For reference, this is what our list of accounts looks like in Salesforce. This is just an

example database, so there are only 15 accounts.
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Back in Zapier we’ll continue setting up the action. For the search, we’ll get all

accounts where “Deleted” is false, meaning all active accounts.
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We’ll click “Test & continue”. We don’t want to skip the test because then we’d have

to wait until the Zap fires naturally on Sunday night to pull the data into Spider

Impact.
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In the records panel we can see 15 results, which matches the number of accounts

we have in our test Salesforce database. Now we need somewhere to send this

data, so we’ll click the “+” button to add a second action in our Zap’s chain. This

isn’t super intuitive, and we hope Zapier improves this process.
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This time we’ll choose Spider Impact under App event. You may need to search for

it.
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We’ll choose “Push Data for Import” for the event, and we’ll click Continue.

Then we’ll choose the connection we set up earlier and click Continue.
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Now we need to choose a unique Nickname for this Zap that we’re creating. Later,

when we’re creating a Zapier data import in Spider Impact, we’ll need to choose

which Zap we want to get data from. This Nickname is how we’ll identify our Zap.
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The next step is choosing which columns we want from Salesforce. These are the

fields that are going to be made available to Spider Impact. We have two options

at first, data from our schedule (like the date the import runs), or data from

Salesforce. We’ll choose Salesforce.
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Zapier suggests some data we may want, but we’ll click “Show all options”.

This lists all the columns available to us. First, we’ll choose the account’s name.



USING SPIDER IMPACT 63

And on the left we’ll type “Account Name” to identify the column for Spider

Impact.

We’ll do the same thing for the “Annual Revenue” and “Country” columns from

Salesforce. We’ll also add an “Import Date” column from the schedule. Then we’ll

click Continue.
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Zapier shows us a preview of the data, and we’ll click “Test & continue”.
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The results say that our import worked, so we’ll click Publish Zap.

One more confirmation and we’re good to go.
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Finally our Zap is published. We can see a summary of our Zap, and in the upper

right corner we can see that it’s turned on.

Importing data in Impact

To import Zapier data in Spider Impact, start a data import like you would with

any other data source. In this example we’re creating a new dataset.
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Choose the Zapier import connection that we set up earlier, and then choose one

of its Zaps. If you don’t see the nickname of a Zap that you’ve set up in Zapier, it’s

most likely because that Zap hasn’t been triggered yet.
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Next is the optional data transformation step.
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And finally is the step where you choose which fields you want to create in the

dataset. As you can see, these are the fields we set up earlier in our Salesforce

Zap.
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When we click Create we now have a dataset with our 15 Salesforce account

records.

Now that our dataset is built, there’s one more thing to do. Right now, Zapier is

sending data to the Spider Strategies Zapier server on a regular basis, but Spider

Impact isn’t regularly reaching out to the Spider Strategies Zapier server to get it.
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So, we’ll go to the Datasets Edit tab and click the “Edit” button for the import

schedule.

We’ll turn on “Schedule Import” and have it run 15 minutes after Zapier sends the

data every Sunday night.
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Zapier import size limit

Every time a Zapier import runs, it is currently limited to 6 megabytes of

transferred data. That’s over 50,000 typical records, so it’s very unlikely that you’ll

hit this limit when importing KPI or initiative values, or when adding records to a

dataset. It is possible that you’ll hit this limit when replacing all records for a large

dataset, so Zapier may not be a good fit for those situations.
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Transforming Values While Importing

Overview

Many types of imports have an optional step to transform your data. This is useful

for things like cleaning your data or for skipping over data you don't want to

import. In the example below, we're importing KPI values, but transformations

work the same regardless of what kind of data you're importing.

Adding Transformations

The transformation step of all imports is optional, so if you want to import your

data as-is, just click next. If you want to change your data before it’s imported,

however, click Add Transformation.

This opens the add transformation menu where you can apply any combination of

dozens of types of transformations to your data.
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For example, you can create a filter to set the KPI value to N/A if the value column

is less than 1.
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Here we’re adding “My” to the beginning of every KPI name.
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You can even use transformations to do data cleanup, like removing all non-

numbers from the Value column.
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Regular Expression Filter

The "matches regular expression" filter is incredibly powerful, but it's also very

technical. Regular expressions are used in software development and some

advanced software applications to match text. In this example, the regular

expression b[aeiou]bble will match the following words:

babble

bebble

bibble

bobble

bubble

There are resources across the web to help you learn how to make a regular

expression to match the text you want. We've also found that RegExr is an online

tool that works well for building the perfect regular expression.

Regular Expression Transformation

Regular expressions are incredibly powerful for text matching, but they can also be

used to transform your data. For example, let’s say you have a field that has text

values like this:

https://regexr.com/
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1440×900 pixels

1600×900 pixels

800×600 inches

And you want to convert it to values like this:

Width: 1440×Height: 900 pixels

Width: 1600×Height: 900 pixels

Width: 800×Height: 600 inches

You can do this by choosing the “matches regular expression” filter type and

writing a regular expression with groups. You can then manipulate the groups as

separate transformations.
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”By converting to date” Transformation

Spider Impact does a great job of turning text into dates on its own, but

sometimes you'll need to give it a push in the right direction when your source data

isn't in a common format. The “by converting to a date” filter turns text into dates

by telling the software where to find the day, month, and year.

Days, months, and years are represented by the following characters:

d

m

y

To separate the days, months, and years, any number of the following characters

can be used

space ( )

hyphen (-)

https://support.spiderstrategies.com/hc/en-us/articles/4417635051156
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comma (,)

forward slash (/)

For example, if your dates look like 5/15/2020, you’d use m/d/y for the source date

format. If your dates look like 3-Mar-19, you’d use d-m-y for the source date

format. As long as you tell Spider Impact where to find the data, it’s smart enough

to determine that Jan, January, and 1 are the same thing.

There are times, of course, where you’ll come across date formats that Spider

Impact can’t parse on its own. For example, February 20th, 2018 could be stored

as 022018, but there's no way for the software to automatically determine which

numbers match to which parts of the date. In these situations, you can apply

regular expression transformations to the data before converting it to a date.

Here we:

�. Start with text like 022018

�. Convert it to text like 02-20-18

�. Parse it into a date with m-d-y
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Importing Date and Time Fields

Overview

Date fields are used in almost every type of import. For example, KPI value imports

require a date field, initiative imports have start dates, and datasets can have

date or time fields. If your date fields are coming from a single field in a database

or Excel spreadsheet, it's easy for Spider Impact to know how to import the date.

When your dates are coming from a text format like CSV or JSON, however, or

when they're the result of combining multiple fields, things can get a little more

tricky. That's because different countries and languages store dates differently,

and Spider Impact doesn't have any clues from the source file to determine how to

read the dates. In these situations, the software goes through a specific order of

possible date formats, many of which are unique to each locale.

Don't worry, you probably won't have to even think about this. If you try to import

dates that look good to you, there's a good chance Spider Impact will be able to

import them. For the sake of transparency, however, here are the full details of

how Spider Impact imports dates.

Details

Attempt 1: Bulgaria

If the user's browser locale is set to Bulgaria, Spider Impact will first attempt to

parse text like 01.25.2021 as January 14th, 2022. If the user isn't from Bulgaria or

the text isn't in that specific format, the software will continue to attempt 2.

Attempt 2: Browser locale-based formats

For most users, the first thing that Spider Impact tries when trying to turn text

into a date is Java's built-in date parsing. It looks at the user's browser to
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determine their locale, and then asks Java to treat the text as a date for that

locale.

There are four formats for each locale: Full, Long, Medium, and Short. For example,

here is the date January 14th, 2022 for each of the formats for the United States

locale.

  Date Time Datetime

Full
Friday, January 14,

2022 AD
3:46:00pm EST

Friday, January 15,

2022 at 1:12:45 PM

Eastern Standard

Time

Long January 14, 2022 3:46:00 PM EST
January 14, 2022 at

1:46:00 PM EST

Medium Jan 14, 2022 3:46:00 PM
Jan 14, 2022,

15:46:00 PM

Short 01/14/22 3:46 PM 1/14/22, 3:46 PM

Java supports over 4,000 locales, so we've put together a spreadsheet with

examples for every locale. 

http://resources.spiderstrategies.com.s3.amazonaws.com/docs/date_time_by_locale.csv

Attempt 3: Specific formats

If none of the locale-based formats match the text, Spider Impact will then

attempt to parse the text using this specific list of formats. We're continuing to

use January 14th, 2022 as an example. Missing year is assumed to be current year.

Dates

1/14/22 

01/14/22 

1/14/2022 

01/14/2022 

1/14 

http://resources.spiderstrategies.com.s3.amazonaws.com/docs/date_time_by_locale.csv
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01/14 

1-14-22 

01-14-22 

1-14-2022 

01-14-2022 

2022-1-14 

2022-01-14 

1-14 

01-14 

jan 14, 2022 

Jan 14, 2022 

JAN 14, 2022 

jan 14 2022 

Jan 14 2022 

JAN 14 2022 

MMM-d-yyyy 

jan-14-2022 

Jan-14-2022 

JAN-14-2022 

January 14, 2022 

january 14, 2022 

January 14 2022 

january 14 2022 

jan 14 

Jan 14 

JAN 14 

January 14 

january 14 

14 January 2022 

14 january 2022 

14-jan-2022 

14-Jan-2022 

14-JAN-2022
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Times

3:46 pm 

3:46 PM 

3:46:00 pm 

3:46:00 PM 

03:46 pm 

03:46 PM 

03:46:00 pm 

03:46:00 PM 

15:46 

15:46:00 

15:46:00.0 

15:46:00.00 

15:46:00.000 

15:46:00.0000 

15:46:00.00000 

15:46:00.000000

Datetimes

To create a Datetime field, Spider Impact combines any of the date formats with

any of the time formats. The date and time is separated by either a [space] or T.

1-14-2022T15:46:00 

1-14-2022 15:46:00

Attempt 4: No day of the month formats

If the date doesn't match any of the formats specified above, Spider Impact tries

the following formats, assuming that it is the first day of the month. We're using

January 2022 as an example. 
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1-2021 

01-2021 

1/2021 

01/2021 

2021-1 

2021-01 

2021/1 

2021/01 

Jan 2021

Attempt 5: ISO 8601 date format

If none of the date formats match, Spider Impact will attempt to parse the dates

as ISO 8601. This is a well-defined format, but here are some examples for

January 14th, 2022.

2022-01-14 

2022-01-14T15:46:00+00:00 

2022-01-14T15:46:00Z 

20220114T154600Z

https://en.wikipedia.org/wiki/ISO_8601
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Managing Imports and Connections

Managing Imports

The Admin > Imports screen is where users can go to manage their saved imports.

Everything is organized by import type, and you can create a new import by

clicking on the New Import button for that type.

Users who are in a group with the “Manage all Imports” or “Application

Administration” permission are able to see and edit all imports. Otherwise, they

can see and edit imports that they (or a group that they’re in) own.

You can apply a filter at the top of the page to change which imports are showing.

You can filter based on things like owners, names, and whether the last import was

successful. If there are more than 10 saved imports, this screen will automatically

add a filter for only your imports to save time when you first view the screen.
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Clicking on one of the imports will expand the row to show the import details. You

can see the results of the last import, edit the import details, or change its

schedule.
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Import Connections

The Admin > Import Connections screen is where you go to manage all of the data

sources that Imports use. Users with the “Application Administration” permission

can see all imports. Otherwise, you can only see the imports to which you have

been assigned an owner.
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Scorecards

Overview of Scorecards

The Scorecard Tree

The Scorecards section is the heart of Spider Impact. It's where you keep all of

your performance metrics, as well as where you manage your overall strategy as

an organization.

The idea behind Scorecards is simple. At the bottom of your scorecard tree are

KPIs. (If you're using the balanced scorecard language, they're called measures,

but it's just a different name for the same thing.) Each KPI has a goal, and every

month the KPI's actual value is compared against the goal to give it a score and a

color.
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All of those KPI scores are then rolled up the tree to give scores to your higher-level

strategic scorecard items. In this example, the score from this Training Revenue KPI

is combined with other similar KPI scores to give the Increase Revenue objective a

score. That objective score is then rolled up with other objectives into the overall

Financial perspective's score.

Overview Tab

The Scorecards overview tab shows all of the information about a scorecard item

and how it's performing. As you click around the scorecard tree on the left, the

information for the selected item is shown on the right.
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�. The speedometer shows the performance for the current calendar period

(purple arrow). In this example we're looking at a KPI and we can see its

actual value, goal, and how much it has changed since the previous period.

�. The historical performance chart shows how this KPI has changed over time.

You can hover/tap on the chart to see the specific values.

�. The actual and threshold values table includes everything that goes into the

score calculation. In this example we're looking at a monthly KPI in quarterly

mode (purple arrow), so we see three months' worth of data in the table.

�. You can designate just about anything in Spider Impact as a related item.

For example, you may want to link to a supporting document in the Files

section. If you choose an Initiative as a related item, Spider Impact will tell

you if the initiative appears to be affecting this scorecard item's

performance.

�. You can create notes for scorecard items that can apply either to specific

periods, or to the scorecard item in general.
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KPIs (or Measures) Tab

When you're viewing a high-level strategic scorecard item, you'll sometimes see a

red icon on the KPIs tab. (This tab is called Measures when you're using balanced

scorecard language.) This means that there's a red KPI somewhere under this

scorecard item.

If you click on the KPIs tab, you'll see the performance of every KPI that is

underneath the currently selected item. This is a great way to see all of the low-

level data that's behind a high-level strategic item.
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Scorecard Building Basics

Editing Scorecard Items

To edit an existing scorecard item, just select it in the tree on the left and then go

to its Edit tab.

Creating New Scorecard Items

To create a new scorecard item, select its parent in the tree and click the New

Scorecard Item button. This will put a placeholder for the new item in the tree and

you can start filling out the form.
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Once your scorecard item is ready to go, click the Create button (or type the

return/enter key on your keyboard).
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Not only does this save your scorecard item, but it also automatically moves on to

creating the next scorecard item in the list.

With a little practice you can quickly create all of your scorecard item siblings this

way at once. Just type the scorecard item's name, hit enter on your keyboard, and

then start typing the next item's name. You can also hit tab to jump to another

field like Description.

Assigning Owners

You can assign users or groups a an Owners of any scorecard item and optionally

send them an alert when they've been assigned.
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Accountability is incredibly important to managing your organization's strategy.

By clearly stating who is responsible for a KPI, there will be a point of contact if

performance starts to take a turn for the worse.

It's also helpful for the owners because they'll know exactly what they're

responsible for. They're able to see a list of all KPIs they own in the Home section.
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KPI (or metric) Details

KPIs (or metrics if you're using balanced scorecard language) are a little more

complicated than other types of scorecard items. The good news is that all of the

default KPI settings work wonderfully. Most of the time you can just give your KPI

a name, an owner, and a couple threshold values. If you really want to customize

your KPIs, though, Spider Impact has the tools to do it.

First, let's review all of the KPI details.
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�. Scoring Type is how your KPI gets its score. The default Goal/Red Flag

option is the most popular by far. You choose a number where your KPI turns

green, and a number where your KPI value turns red. Please see our Using

KPI Scoring Types article for more information.

�. Calendar is how often you update your KPI.

�. Data Type is the kind of number you want to use. You can choose Number,

Percentage, or Currency.

�. Aggregation Type is how to combine KPI data for multiple periods. For

example, a monthly KPI's quarterly totals. Most KPIs are Sum or Average,

but there are also options for Geometric Mean and Last Value (already

aggregated).

�. Decimal Precision is how many numbers you want to the right of the decimal

point. You can also set the default decimal precision for Spider Impact in the

Application Administration section.

�. Currency allows you to choose a specific country's currency and is only an

option when configured in the Application Administration section.

https://support.spiderstrategies.com/hc/en-us/articles/360041554151
https://support.spiderstrategies.com/hc/en-us/articles/360041178372
https://support.spiderstrategies.com/hc/en-us/articles/360041178372
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When you choose Number for the data type, you also have the ability to specify a

unit of measurement if you've configured Units in the Application Administration

section.

KPI Series

Every KPI has actual values that are updated regularly. Depending on the KPI's

scoring type, it may also have one or more scoring thresholds that can change

month to month.

In this example we're using Goal/Red Flag scoring and we have three series to

configure:

�. Every series has an update type. It defaults to manual, but you can also

choose Calculated or Template Rollup. Please see the Calculated KPIs article

for more information.

https://support.spiderstrategies.com/hc/en-us/articles/360041178372
https://support.spiderstrategies.com/hc/en-us/articles/360041117552
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�. Every manual threshold has a default threshold value. In this example our

KPI will turn red if the value us lower than 255,000 and green if it's higher

than 260,000. When higher values are worse, the Goal threshold is going to

have a lower number than the Red Flag threshold.

KPI Updaters

The last thing you can configure for KPIs is Updaters. Here you can designate one

or more users or groups as updaters for the KPI. By clicking the Update Thresholds

checkbox you can also give them the ability to change things like the KPI's goals

for each period.

Rearranging the Tree

When you're on the Edit tab, you can rearrange your scorecard items by dragging

and dropping them in the tree.
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Editing Multiple Scorecard Items at Once

On the top of the Edit tab is a blue notification box explaining how to edit more

than one scorecard item at the same time. Please see the Editing Multiple

Scorecard Items at Once article for more information.

https://support.spiderstrategies.com/hc/en-us/articles/360041614871
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Using KPI Scoring Types

This article covers how each of the different KPI scoring types works. For

information about choosing which scoring types will appear as options for your

KPIs, see the Editing Scoring Types article. For information on changing how scores

are displayed, see the App Administration: Scoring article.

Overview

There are many different Scoring Types that you can choose for a KPI.

Every scoring type changes the things that you can configure for the KPI, and all of

the scoring types are configured in the Scoring Types page in Administration.

https://support.spiderstrategies.com/hc/en-us/articles/10022397290260
https://support.spiderstrategies.com/hc/en-us/articles/360041729131
https://support.spiderstrategies.com/hc/en-us/articles/10022397290260
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Goal/Red Flag

The default KPI scoring type is Goal/Red Flag, and it's the most popular option by

far. You choose a number where your KPI turns green, and a number where your

KPI value turns red.

In this example our KPI will turn red if the value us lower than 255,000 and green if

it's higher than 260,000. When higher values are worse, the Goal threshold is

going to have a lower number than the Red Flag threshold.

The three colored segments of a Goal/Red Flag speedometer will always be the

same size. The Goal is where the score is 6.6 and the Red Flag is where the score is

3.3. Your score will hit 10 at:

(goal - red flag) + goal.

This is better explained with an example. Let's say our goal is 700 and our red flag

is 500. There's 200 between the goal and red flag. In Goal/Red Flag scoring, that

means:

Score is 0 when the actual value is 200 less than the Red Flag (300)

Score is 10 when the actual value is 200 more than the Goal (900)
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You actually need 4 thresholds to draw a speedometer with 3 colors. Goal/Red

Flag scoring automatically calculates the highest and lowest thresholds for you,

though. This way you only have to tell Spider Impact at what value your KPI turns

green and at what value it turns red.
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Unscored KPIs

Unscored KPIs are great for tracking things that don't make sense to score.

Unscored KPIs have no thresholds, just an actual value.
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This is what an unscored KPI looks like when visualized.

Yes/No Scoring

Yes/No KPIs track a yes or no value every period rather than a number. They don't

have thresholds, but you do tell Spider Impact whether Yes is good or not.
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This is what a Yes/No KPI looks like on a manual update form.

Goal Only Scoring

Goal Only KPIs have a single threshold. If you hit your goal you're green. If you

don't you're red. There's also a setting to tell Spider Impact whether higher values

are better.
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This is what Goal Only KPIs look like. Notice how the speedometer needle is always

directly in the middle of its color segment.

Stabilize Scoring

Stabilize Scoring is great for when you don't want your KPI values to be too high

or too low. They also have a very large number of thresholds.
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This is what a Stabilize KPI looks like. Notice how not every color segment is not

the same size because we typed in threshold values that aren't evenly spaced.
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Text Scoring Types

Text KPIs have pre-defined text values instead of numbers. Scored text KPIs are

the same as unscored text KPIs except they have a score and color associated with

every value.

In this example, you can choose between values of "Failed", "Meets Expectations",

and "Exceeds Expectations" when updating the KPI.
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And because scored text KPIs have colors and scores, they can be graphed just like

any other scorecard item.
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Every Other Scoring Type

Every other scoring type is similar. They're all just different variations of color

selection, and some even include colors like blue or dark green. All you have to do is

enter the color thresholds and Spider Impact will score your KPI.

For example, here's a 4 Color Orange KPI.

And this is what that KPI looks like. Again, we don't have evenly spaced thresholds

so the segments are different sizes.
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Choosing and Editing KPI Scoring Types

All scoring types are managed in the Administration section. You can choose which

default scoring types appear as options when building KPIs, and you can create

your own custom scoring types:

Custom Number

Custom Stabilize Number

Scored Text

Unscored Text

For more information, see the Editing Scoring Types article.

https://support.spiderstrategies.com/hc/en-us/articles/10022397290260
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Calculated KPIs

Overview

You can set up KPIs to automatically calculate their actual values and thresholds

from other values in Spider Impact. For more information about what Spider

Impact actually does when it's calculating a KPI field, please see the Exploring

How a KPI is Calculated article. For a comprehensive list of all equation syntax and

functions, see the Equations article.

Calculated KPI Details

Let's start things off with a simple example. We're going to create a calculated

KPI called Total Revenue that is the sum of Product Revenue, Training Revenue,

and Book Revenue.

There's a lot going on in the Edit tab, so we'll look at each configuration option one

at a time.

https://support.spiderstrategies.com/hc/en-us/articles/360050048411
https://support.spiderstrategies.com/hc/en-us/articles/4407643362452
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�. We've changed the KPI's actual value from Manual to Calculated.

�. The Goal and Red Flag thresholds are still manually updated. As you can see,

we've typed in default values for both.

�. We can choose a Manual Aggregation Type like Sum or Average. This only

applies to the threshold values because they are manually updated.

�. We can choose a Calculated Aggregation Type. The options here are Sum

(recommended) and Use Equation. This only applies to the Actual Value

because it is calculated.

�. By default, if a KPI equation is referencing a value that is blank, the entire

equation will immediately evaluate to blank. You can instead choose to treat

missing values in the equation as 0,  N/A, or Blank.

�. This is the button to set the KPI's equation. We'll cover that next.

KPI Equations

When you click the Set Equation button, it shows a dialog for building the equation

for that series.
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�. This is where the equation that we're building goes. You can type text

directly here.

�. This builds functions that we send into the equation.

Next we're going to choose the KPI that we want to reference by clicking

the Select a KPI button.

This stacks a second-level dialog where we choose the Product Revenue KPI.
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When we click Done and the second-level dialog closes, our equation builder now

looks like this.

�. The item type is KPI. We'll explain below how to reference other things like

Initiatives and Scores.
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�. This is the Product Revenue KPI that we selected. If you want to change the

item we're going to reference in the equation, just click this button again.

�. We're going to include Product Revenue's actual value in the equation, but

we could reference one of its thresholds like Goal instead.

�. We're going to include Product Revenue's value for the current period, but

we could choose earlier or later periods.

�. When we're ready to add the data to the equation, click this Add button.

Once you add a reference to a KPI, it looks like this:

As you can see, the syntax for referencing another KPI value is:

M(kpi_id)

Now we'll type in a [space], a [+], and a [space], select the Training Revenue KPI in

the second-level dialog...
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... and click Add.

One more time and our equation is finished. Let's click Done.
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Back on the Edit tab, our equation now shows up for the Actual Value series.

When we save the KPI and visit the Scorecards Overview tab, we can now see our

calculated KPI in action.
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Common Equation Syntax

The Equations article has a comprehensive list of all functions and operators that

you can use in your equations, but here are examples of some of the most

commonly used syntax.

Most Common Formulas Format

Sum sum(x, y, …)

Average avg(x1, x2, x3, …)

If if(condition, truevalue, falsevalue)

Round round(x), round(x, decimal_places)

To Date (YTD, QTD, etc.) TD(calendar, kpi_id, series, aggregation)

Referencing a KPI (metric) value M(kpi_id)

Referencing an Initiative Value I(field, initiative_id)

https://support.spiderstrategies.com/hc/en-us/articles/4407643362452
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If you select a block of text in your equation, a tooltip dialog will appear allowing

you to wrap the selected text in a function.

Self-Referential Equations

You can also choose This KPI when building equations. This allows you to make

self-referential equations, for example goals that are automatically 10% higher

than the previous year’s actual value.
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To reference a KPI's own value, the syntax is simple:

M()

If you want to reference a KPI's own threshold (Red Flag), it looks like this:

T(Red Flag)

A KPI's own value for three periods earlier looks like this:

M(-3p)

Similarly, a KPI's own threshold (Goal) from three periods earlier looks like this:

T(Goal, -3p)
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Referencing Scores

You can include the score from any scorecard item in your equation. Just

select Score from the Type dropdown on the left.

This is the syntax for referencing the score for the current period for a scorecard

item with an ID of 123 is:

S(123)

The syntax for referencing a scorecard item's score in another period is similar. In

this example, we're referencing the score from the previous period for item 123.

S(123, -1p)

Referencing Initiative Values

You can include vales from Initiative items by selecting Initiative in the Type

dropdown on the left. Here we're using the Total Budget from the Migrate Servers

to the Cloud initiative in our equation.
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They syntax when referencing an initiative value is:

I(field, initiative_id)

For example, to reference the budget remaining for initiative 123, the equation

would be:

I(BR, 123)

You can reference values for these initiative fields:

BR – Budget Remaining

DE – Days Elapsed

MSTD – Money Spent to Date

PBV – Projected Budget Variance
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PBVP – Projected Budget Variance Percentage

PC – % Complete

PCOST – Projected Cost

PSV – Projected Schedule Variance

PTE – % Time Elapsed

TB – Total Budget

To-Date Function

By choosing To Date in the Type dropdown, you can build equations that

aggregate values over time. The most popular use of the to-date function is

calculating Year To Date values. In this example we're including the Sales

Revenue quarterly sum.

The syntax for the to-date function is

TD(calendar, kpi_id, field, aggregation)

For example, if we wanted to do an average year-to-date for actual value of the

KPI with an ID of 123, the equation would be:
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TD(Yearly, 123, Actual Value, Average)

If/Else

The syntax for an IF statement is:

if(condition, truevalue, falsevalue)

Here's an example equation. "If the value for KPI #123 is 5, this equation returns

10. Otherwise return 0."

if(M(123) == 5, 10, 0)

Note that you'll need to use the double equal operator == when checking for an

equal value, as explained below.

You can also string together multiple IF statements to create an IF/ELSE chain like

this. "If the value for KPI #123 is 5, return 10. Else if the value for KPI #123 is 4,

return 100. Else return 0."

if(M(123) == 5, 10, if( M(123) == 4, 100, 0))

Yes/No KPI Values

Most KPIs have number for values, but Yes/No KPIs are different. These can be

referenced as booleans (true/false) or as numbers (1/0).

In this example, we're building an equation for a number KPI, and we're using the

value from a Yes/No KPI in that equation. "If the value for KPI #123 is yes, return 5.

Else return 20"
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if(M(123), 5, 20)

It goes the other way too. In this example, we're building an equation for a Yes/No

KPI, and we're using the value from a number KPI in that equation. "If the value for

KPI #456 is greater than 7 return true. Else return false"

if(M(456) > 7, true, false)

This is the same as:

if(M(456) > 7, 1, 0)

Note that in the example above we're using 1 and 0, but any non-zero number will

evaluate to Yes in a Yes/No KPI's equation.

Because Yes/No KPI values are treated as 1 and 0, you can even use them in

functions just like any other KPI value. In this example we're building an equation

for a calculated Yes/No KPI. This equation looks at three other Yes/No KPIs. If

most of them are yes, it returns yes. If most are no, it returns no.

if(avg(M(123), M(456), M(789)) > 0.5, true, false)

Blank (null) and Not Applicable (N/A)

In addition to their normal values, KPIs can also have values that are:

�. Blank (also called null).

�. Not Applicable (also called N/A). This is only available when the "Show N/A

Option" is enabled in Application Administration.

https://support.spiderstrategies.com/hc/en-us/articles/360041729131
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You can reference N/A and empty values using the `isblank` and `isna` functions

like this:

if(isblank(M(123)), 5, 20)

and this:

if(isna(M(123)), 5, 20)

To set a value to empty, the equation would look like this:

if(M(123) > 8, blank, 20)

Returning a N/A value would look like this:

if(M(123) > 8, na, 20)
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Full equation syntax

For a comprehensive list of all equation syntax and functions, see the Equations

article.

https://support.spiderstrategies.com/hc/en-us/articles/4407643362452
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Exploring How a KPI is Calculated

Introduction

Spider Impact is great at calculating KPI values and aggregating them over time

and across organizations. It's important for everyone in your organization to have

complete faith in how a number was calculated, however, and Spider Impact

shows its work.

For example, it can sometimes be difficult to understand the nuanced differences

between aggregation types like “sum” and “use equation.” Although this

explanation gets a little technical, don’t worry, Spider Impact is easier to use than

ever. The big take-away here is that that you can hover your mouse over a number

on the Scorecards Overview tab to see how it was calculated.

Exploring KPI Calculations

On the Scorecards Overview tab there is an “Actual and Threshold Values” table

that shows you all of the KPI values and thresholds that go into the currently

selected KPI, regardless of whether those values are calculated or not. You can

interact with these numbers to see where they come from.

In this example, we’re looking at a monthly KPI in quarterly mode. The KPI’s

aggregation type is average, so its quarterly total of 1,869 was determined by

averaging its three monthly values listed in the “actual and threshold values” table.
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If you hover your mouse over the April 2018 monthly values, you can now see that

it’s based on an equation using the values of four other KPIs.
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If you want to explore further, just click the monthly number that you’re hovering

over. This shows a dialog containing both the original equation and a version of the

equation with April 2018 actual values substituted for the KPI references. When

you hover over individual parts of the equation, there’s a tooltip telling you the

name of that KPI, and its corresponding actual value is highlighted below.
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Finally, you can click on any of these KPI references to go to that KPI’s Scorecard

Overview tab. By doingthis, you can trace down complicated nested equations to

find out exactly where a calculated number comes from.

Instead, we’ll edit our original KPI to show how the software visualizes different

aggregation types. We’ll change the calculated aggregation type from “average”

to “use equation.”
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Now when we go back to the Overview tab, things look different in the “actual and

threshold values” box. The goal and red flag thresholds are manually updated for

this monthly KPI, so they’re still in monthly rows. But, a single quarterly actual

value is now listed on top rather than separate actual values for every month.
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That's because when we changed the calculated aggregation type, the software

calculates the KPI’s quarterly value differently.

As we saw earlier, this KPI’s actual value is calculated, and its calculated

aggregation type is now “use equation” rather than “average.” The “average”

aggregation type calculated each of this KPI’s monthly values and then averaged

them. The “use equation” aggregation type does things in the opposite order.

Itfirst calculates the quarterly values for every KPI referenced in the equation, and

then plugs those values into the equation.

Long story short, this KPI’s monthly values aren’t directly used to determine its

quarterly value anymore, so the software doesn’t show those monthly values in the

table.

Just like before, when we hover over the calculated value, we can see its equation

in the tooltip.
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And, like before, clicking on the calculated number shows a dialog. This time,

however, the equation is using quarterly values rather than monthly. You can see

that each of the KPIs in the equation have first been aggregated on their own,

because their Quarter 2 values are used in the equation.
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Linked Scorecard Items

One of the scorecard item types that you can choose is Linked Item. This allows

you to add a copy of an existing scorecard item to your scorecard. For example,

you may want to reuse a KPI that's already being tracked in another organization,

or maybe you want to create a theme scorecard that includes objectives from

other organizations.

Whenever that source item is updated with new KPI values or scores, that

information will instantly be reflected in your linked item.

There are two things that make linked items unique from other scorecard items.
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�. You need to choose where the source item is. In this example we're choosing

the "Product Revenue" KPI from the "Financial" organization.

�. You need to choose what to pull from the source item. It's always going to

reuse things like scores, actual values, and thresholds because that's the

point of a linked item. But, you can choose to override things like the item's

Name, or you can decide to not share Notes with the source item.
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Editing Multiple Scorecard Items at Once

The mass-edit feature allows you to edit multiple scorecards at once, and it can

save you a lot of time. To start, go to the Administration section, choose "Mass

Edit Scorecard Items", and then click the “Choose a Field to Edit” button.

In this example we’ll choose Owners.
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Next, we’ll add a filter to choose which scorecard items show up to edit.

The default filter is “Specific Scorecard Items,” and we’ll use that here.
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We’ll add the entire “Mobileworld Balanced Scorecard” and click Done.
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Now we can see all of the scorecard items for the Mobileworld Balanced

Scorecard. You can edit a few at a time, but we’re going to select all and click “Edit

Selected Items”.

We’ll add the Human Resources group as owners.
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After clicking Save, we see a message summarizing all of the changes that were

made. If some of the changes didn’t work, it explains why as well.
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Dashboards

Building Dashboards

Creating a Dashboard

New dashboards default to Blank, but you also have the option to automatically

add widgets for each KPI in the organization. This can be a great starting point for

building KPI dashboards.

In this example, we’ve selected speedometers, and when you click “create,” the new

dashboard starts with a speedometer for every KPI in the organization.
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This is what the dashboard would have looked like if we had chosen bubbles.
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Adding Widgets

To add a widget, click the Add Widget button in the button row.

This shows the Add Widget menu, where you can choose what you want to add to

your dashboard.
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Each type of widget has unique configuration options, many of which are

discussed in separate articles.

Image

Text

Bubble

Embedded

Speedometer and Linear Gauge

Notes

Gantt

Initiative Chart

Dataset

Chart and Report

https://support.spiderstrategies.com/hc/en-us/articles/360041554171
https://support.spiderstrategies.com/hc/en-us/articles/360041553471
https://support.spiderstrategies.com/hc/en-us/articles/360041554011
https://support.spiderstrategies.com/hc/en-us/articles/360041118912
https://support.spiderstrategies.com/hc/en-us/articles/4408589452948
https://support.spiderstrategies.com/hc/en-us/articles/360041554271
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Arranging Widgets

Editing a dashboard is a lot like editing a PowerPoint slide. You can drag and resize

dashboard widgets to create any layout you want. See the Widget Spacing,

Alignment, and Sizing article for more information.

Automatically Resizing Canvas

Your dashboard canvas will automatically expand as wide as you want it to be. For

example, we can start dragging this chart here:

https://support.spiderstrategies.com/hc/en-us/articles/360026926351
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And then watch the canvas grow as we drag it away from the pie chart.
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When you're viewing your dashboard, the size of your canvas doesn't matter.

Spider Impact automatically zooms the dashboard so that it fits on screen. This is

a lot like how PowerPoint presentations never have scroll bars during the

presentation, but they do when editing.
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Here we've made the browser very short and the dashboard resizes to fit.

Of course you can always click on the space around the dashboard to zoom in.

Clicking again will zoom you back out.
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Automatic Ordering

Spider Impact automatically puts smaller dashboard widgets on top of larger

dashboard widgets, completely avoiding the "move forward" and "move back"

hassles seen in other software. For example, if you put small performance bubbles

on top of a chart, they'll be above the chart so you can see them.
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If we resize these exact same widgets and put the chart over one of the bubbles,

however, the chart is now on top.

Keeping smaller widgets on top of larger widgets works great the vast majority of

the time. If you're doing very complex layouts, however, there are times when you

want to force a widget to the top.

In this example, we have an award image that we want to cover several smaller

bubble widgets. Spider Impact is bringing the smaller bubble widgets to the front,

though.
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To force the award image to the top, we're going to turn on the "Keep in Front"

toggle in the widget's configuration menu.
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Rotating Widgets

Text and Image widgets can be rotated using their rotation handles.

https://support.spiderstrategies.com/hc/en-us/articles/360041553471
https://support.spiderstrategies.com/hc/en-us/articles/360041554171


USING SPIDER IMPACT 160

Locking Widgets

Because dashboards automatically put larger widgets underneath smaller

widgets, you can upload a large background image and your smaller widgets will

appear on top of it.

If you aren’t careful, however, you can accidentally move your background image as

you’re editing other widgets. To solve this problem, just select the background

image and turn on "Lock".

Not only does locking a widget prevent it from moving, but it also prevents it from

being selected along with other widgets. So, when the background image is locked,

you can drag to select all of the widgets on top of it without selecting the

background image itself.
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Please see the Dashboard and Strategy Map Backgrounds article for more

information about all of the ways you can make dashboards even better with

background images.

 

https://support.spiderstrategies.com/hc/en-us/articles/360053221832
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Widget Spacing, Alignment, and Sizing

Resizing

When you select a widget, you'll see resize handles on the sides and corners.

Just drag them to resize the widget.

You can also select multiple widgets (with drag or shift-click) and resize them all at

once. Here we're resizing the two wide charts on the right.



USING SPIDER IMPACT 163

To resize widgets to specific dimensions, choose “size” in the widget's configuration

menu, and then type in a height or width. If multiple widgets are selected, your

changes apply to them all. In this example, all of the widgets have the same width

of 165, so it pre-fills that number in the size menu.

When we change the width to 90, all of the widgets instantly resize.
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Align

You can select multiple widgets and then align them with top, bottom, right, left,

middle vertical, or middle horizontal alignment. In this example we’ve selected four

dashboard widgets.
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When we click the align top button, it moves all of the selected widgets to the

highest point of all four widgets.

Distribute

The Distribute button allows you to select multiple widgets and then evenly space

them horizontally or vertically. This example shows four widgets that are not

evenly spaced.
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After clicking the button, the widgets are now evenly spaced.

Alignment Snapping Options

There are three different snap-to options when editing dashboards. The default

option is Snap-to Widgets, which uses the size and position of other widgets on

the dashboard as a guide when you’re moving or resizing widgets.
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Another option is Snap-to Grid, which aligns your widget position and size to a grid

that only shows up when you’re editing.

Finally, you can choose Snap-to None, which disables snapping all together. This is

useful when fine-tuning layouts or when there are widgets that are irregularly

placed.
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Dashboard and Strategy Map Backgrounds

Overview

Dashboards and strategy maps look even better when you use image widgets

creatively. For example, you can create a precise layout that looks exactly like the

presentations your leadership team is is used to seeing. This is just a screenshot of

a PowerPoint slide with dashboard widgets on top.

Or you can spice up your dashboard with translucent layout elements, like these

Aviation and Travel background images.
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You can even overlap map images with colored bubbles that show the

performance. This example shows small performance bubbles on European cities.
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In this article we'll show you the general approach to using background images on

dashboards and strategy maps.

Creating the Image

Let's start with a real-world example. The Balanced Scorecard Institute uses this

slide in some of their training materials, and it's a great example of a strategic

planning and management system. How would you get something like this into

Spider Impact?

https://balancedscorecard.org/
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First, let's remove all of the information on the slide that we don't want to show

up in Spider Impact. In PowerPoint that means hiding background graphics. This

removes the slide header and footers.
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Now we're going to remove all information on this slide that we want to

automatically update based on live data in Spider Impact. We end up with this:
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Finally we need to turn that slide into an image, and there are a variety of ways

you can do this. PowerPoint has the ability to export slides as images, but if you do

that, you'll need to edit the image to crop off the extra white space on the edges.

Instead, we're going to take a screenshot of just the relevant part of the slide.

In Windows you can do this by Windows Key + Shift + S, selecting the region you

want, and then pasting it into Paint. On Mac you can do this with CMD + Shift + 4

and it will save the image to your desktop.
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Make sure the image is large enough so that it doesn't look pixelated on your

dashboard. You'll usually be in good shape if your image is at least 1,600 pixels

wide. In this example the screenshot is actually 3,200 pixels wide because I want it

to look good on high resolution screens.

Compressing the Image

Large dashboard images load slowly, so we want to make sure the file size isn't

too big. Most dashboard background images will work best in the PNG format

because they're made of solid colors. If yours has a lot of gradients or photos,

however, JPEG may be a better choice.

Raw PNG images can be very large, though, so we're going to reduce the file size

before we use our screenshot in Spider Impact. There are a variety of tools to do

this, and here we're going to use ImageAlpha and ImageOptim, both of which are

for Mac.

https://pngmini.com/
https://imageoptim.com/mac
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ImageAlpha reduces the size of PNGs by changing the number of colors in their

color palate. In this example our background image still looks great with only 16

colors, and its size is only 10% of what it was before. Every image is different,

though, and you'll often be best at 128 or 64 colors. Be sure to zoom in on the

details to make sure you're not over-compressing.

Next we'll use ImageOptim to strip off all of the extra metadata and make the file

as small as possible. This app works with any image format and has saved us an

additional 12%.
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By using these two apps, we've gone from 825K to 77K. Again, there are many

image compression utilities available that do this exact same thing.

Creating Your Dashboard

Now it's time to add your dashboard. Be sure to resize it large enough so that

there's plenty of room to add content, and the lock it in place.
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And finally we'll add widgets. Here we've added bubbles for the objectives,

measures, targets, and initiatives. For the Measures, Targets, and Initiatives we've

turned off the bubble background so only the text shows up. That way you can

click on the text to drill down for more information.
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When we're done we have a fully interactive dashboard showing live data, all in a

format that our organization is familiar with.
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Image Widgets

Adding an Image widget

Like all dashboard widgets, you can add an image widget from the Add Widget

menu.

Or, to save time, you can just drag and drop an image file from your desktop.
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Shared Images

You can manage shared images in the Files section, and then add those images to

dashboards. To do this, just click the “Add Shared Image” link on an image widget.

https://support.spiderstrategies.com/hc/en-us/articles/360041175232
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This opens a dialog where you can browse for images stored in the Files section. By

default, everything is sorted by organization.
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If you don’t know which organization your image is in, however, you can select “All

Images” at the top of the organization tree. This combines all images from all

organizations on the right.

If you ever want to update the shared image later, just upload a new revision in the

Files section. All of the dashboards using this shared image will automatically

update.
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Using Images for Backgrounds

Please see the Dashboard and Strategy Map Backgrounds article for more

information about all of the ways you can make dashboards even better with

background images.

https://support.spiderstrategies.com/hc/en-us/articles/360053221832
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Text Widgets

Overview

Text widgets are great for adding labels or titles to your dashboards. You can

include text formatting, links, and even rotate them.

Outlines

You can choose an outline color for your text widget as well as the outline

thickness.
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Text Variables

You can use the following variables in text widgets:

[today]

[calendar]

[calendar-period]

[dashboard]

[organization]

When you view the dashboard, these variables will be automatically replaced.
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Chart and Report Widgets

Adding an Existing Chart or Report

To add an existing chart or report to your dashboard, choose one of these items at

the bottom of the Add Widget menu.

Then, just choose a chart or report that you've already created in the Charts or

Reports sections. Impact will copy this chart or report to your dashboard. Any

changes you make to your new dashboard widget will not affect the original item

that you copied.
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Creating a New Chart or Report

If you want to start from scratch, just choose New Chart or New Report from the

menu.
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You can then choose which chart of report type you want. These are the identical

options you'll see in the Charts and Reports sections.
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Editing a Chart or Report Widget

Charts and reports on dashboards are edited in a full-screen dialog. Here we’re

choosing “Edit Chart” on a dashboard widget.

The dialog that opens has all of the chart building functionality from the Charts

section. You can see the changes you make to your chart instantly.

https://support.spiderstrategies.com/hc/en-us/articles/4408581627540
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Similarly, you can choose "Edit Report" on a report widget.
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Again, you build reports here exactly the same way as you do in the Reports

section.

Report Font Size

You can adjust the overall font size for report widgets. By default, they show with

no font size adjustment.

https://support.spiderstrategies.com/hc/en-us/articles/4408579703572
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Here we’ve increased the font size so that the data inside of the table is much

larger.
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Report Cell Margin Size

Similarly, you can adjust report widgets' cell margins. By default they show with

Large margins, which matches the Reports section.
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Here we've adjusted the margins to Small to be able to fit more content on our

dashboard.
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Dataset Widgets

Dataset table widgets

The first type of dashboard widget we’ll add is the Datasets Table widget. To do

this, we’ll click the + button in the upper left corner and choose the Table widget in

the Datasets section.

Then we’ll choose the Fitness Tests dataset.
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Then click the “add” button for the Age and Gender fields.
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This adds two field tables to our dashboard canvas. They’re exactly the same as

the tables that we’re used to seeing on the Datasets Explore tab, except that we

can drag and resize them on our freeform dashboard canvas.
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We can change all kinds of widget formatting options like background, font size,

and rounding of numbers.

This is what it looks like when we save and click to the Dashboards View tab.

Just like on the Datasets Explore tab, when you click on a row in a Dataset Table

widget, it filters all of the results on the dashboard including the other widgets.
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Dataset value widgets

The next type of widget that we’ll add to the dashboard are Dataset Value

widgets. These are similar to Dataset Table widgets except that they only show a

single value.
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In this example we’ll add the average sit-up score, the average push-up score, the

average run score, and the total number of tests.

As before, if you click on a row in a table widget, all of the widgets on the

dashboard update with new values, including the Single Value widgets.
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Dataset filter widgets

Another type of dataset dashboard widget are Dataset Filter widgets. They allow

you to quickly apply filters to your dashboard, without taking up as much space as

a Dataset Table widget.
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Here we’ve clicked on the Gender dataset filter widget and we’ve applied a filter of

Male.
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Turning off the filter type allows filter widgets to be even more compact.
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Notes Widgets

The notes widget allows you to see the notes for a scorecard or initiative item on

your dashboard. You can add the widget from the dashboard Add Widget menu.

The default "Display As” appearance is “Abbreviated tiles.” The widget shows a

preview of each note, as well as an icon showing whether there are any replies.

If you click on the tile, it shows the entire note and its replies in a dialog. 
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If you choose the “Full notes” option, you can now see the entire note and reply

text directly on your dashboard.
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You can choose which things you want to show for each note too. In this example,

we’ve decided not to show the title, replies, or the editing controls.
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Embedded Content Widgets

Adding an Embedded Content Widget

You can add an embedded content widget from the “add widget” menu.

Then, just paste in the URL of the webpage or image that you want to see on your

dashboard.
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Spider Impact will then show that website or image in a resizable widget.
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Sites That Prevent Embedding

It’s important to note that many commercial websites intentionally prevent

themselves from being displayed in other websites. Other sites require setting

cookies, which don't work with embedded content. Because of this, embedded

content widgets work best for content that is designed to be embedded. It's best

to think of this as a widget for showing content meant for sharing, not for

embedding any website on the internet.

For example, here’s the “Embed a map” tab in google maps.

When we copy and paste that code, we get this:

<iframe src="https://www.google.com/maps/embed?pb=..." 
width="600" height="450" frameborder="0" style="border:0" 
allowfullscreen></iframe>

https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/X-Frame-Options
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We only want the URL, though, so this part is all we want to paste into the

embedded content widget.

https://www.google.com/maps/embed?pb=...

If, however, we went to the “Send a link” tab in google maps, we’d get a different

URL that isn’t designed to be embedded.

When we paste that URL into the embedded content widget, Spider Impact will

show an error that looks like this.
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Finally, it’s important to note that any URL you use has to be HTTPS, not HTTP.

Spider Impact is a secure site, and web browsers prevent insecure content from

being displayed in secure sites.

Disabling Embedded Content Validation

As you can see, there's a lot that can prevent a web page from showing up inside

of Spider Impact. We do our best, however, to explain what's going wrong when it

doesn't work. Whenever you paste a URL into an embedded content widget, we

check to make sure that the content can be displayed on your dashboard.

There are some situations, however, where Spider Impact can say that you're not

authorized to embed a page when you really are. For example, if you're hosing

Spider Impact on your own servers (or if you use a VPN or single sign-on), it's

possible that the Spider Impact server is being blocked from seeing a page even

though you are not. If that's the case, you can turn off "Validate Embedded

Dashboard Widgets & Briefing Slides" in Admin > Application Administration.



USING SPIDER IMPACT 217



USING SPIDER IMPACT 218

Charts

Overview of Charts

The basics

Charts visualize data for any combination of Scorecard items, Initiative items, and

Dataset records. Charts are often shown as widgets on Dashboards, but they are

also in the Charts section of Spider Impact.

Creating a chart

To create a chart, go to the Charts section and click the “New Chart” button.

From here you can name your new chart and decide what it should look like. The

default chart type is Blank, but you can choose from a wide variety of example

charts to get you started.
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If you choose a pre-built chart example, you’ll see a fully finished version of your

chart with sample data. This allows you to build visualizations based on how they

look rather than focusing on getting the data exactly right from the beginning. All

sample data series are marked blue.
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Example charts

The most popular charts are line, bar, and area charts. These three types of data

series can be combined on the same chart.
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Pie and donut charts visualize pieces of a whole.
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Polar charts help show cycles and scientific data.
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Diagram charts look best on dashboards, and they present infographic-style

visualizations.
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Building Charts

Editing chart data

Whenever you’re ready to see your own data on the chart, just edit the data source

on a sample data series. In this example there’s a sample bar series on the left axis,

so we’ll click on it and choose “Set Data Source”.

This allows you to choose to show any type of data from scorecard items, initiative

items, or dataset fields. We’ll choose to show the KPI Value for Product Revenue.
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Now our chart is showing real data. All that’s changed is the height of the bars.
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Adding chart data

You can also add data series to your chart one at a time by clicking the “Add Data”

button. Some chart types will ask what kind of data series you want. In this

example the options are a new Line, Bar, or Area data series. We’ll choose Bar.

Next, choose where in Impact to get your data. You can choose a scorecard item

like a KPI, an initiative, or low-level data from a dataset. We’ll choose Scorecard

Item.
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From here you can add bars directly to the chart. Every time you click the add

button, it adds a bar for that scorecard item.

After two clicks of the Add button, we have a chart that looks like this.
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Right axis

Adding data to the right axis is exactly the same process. Here we’ll add a line for a

scorecard item’s score.
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This 0-10 score line is now showing on the right axis while the three bars’ $100k+

Revenue are graphed on the left axis.

Reordering with drag and drop

You can reorder anything on your chart by dragging and dropping. In this example,

the Training Revenue bar comes before the Product Revenue bar.
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After moving Training Revenue to the bottom of the list, its bar is now on the right.
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The order also affects the order above and below other items. Here we’ve moved

the Book Revenue line to the bottom so that it’s underneath the bars.
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You can even drag items to the other axis. Here we’ve moved Book Revenue to the

right axis so that it has its own scale.
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Setting data series names

Data series names are used in various places like chart labels, tooltips, and

legends. Spider Impact chooses a default name for each data series, but you can

override this by choosing Set Name in the edit tooltip.
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Here we’ve decided to change the Product Revenue scorecard item’s name on the

chart to All Revenue.

This new name is now used everywhere for that data series.
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Setting colors

By default, chart data series use automatically assigned colors. You can also

choose to manually change any automatically assigned color.

You can choose a different way to color the data series, however. In this example

we’re going to click on Bar Colors in the Other panel.
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And we’ll change from Manual to Score.

This changes the bars to be colored based on each scorecard item’s score for that

period.
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You can also force all the bars for all data series to a single color by choosing

Specific Color. This is the same as manually setting all data series to the same

color individually.
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X and Y axes

You can configure a chart’s axes through the X and Y Axes box in the Other panel.

The X and Y axis labels default to on, but you can turn one or both off here.



USING SPIDER IMPACT 241

You can also set the Y axis range.

This opens a dialog where you can choose the chart’s maximum and minimum Y

axis values. By default, they’re automatically set, but here we’re overriding the

maximum value to 50.
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As you can see, the chart now shows a maximum value of 50, regardless of what

data is being graphed.
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Chart labels

Most chart types have labels that you can configure. In this pie chart example, you

can see a Pie Slice Labels option in the Other menu.

When we click it, we can see the various label options, including the ability to show

percentages and abbreviated chart values.
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Repeating left & right axes

When you’re graphing scorecard items, you’ll always be able to set your calendar

period range in the Repeat panel. Here we’re showing 6 periods of data for three

KPIs. We can edit the calendar period range by clicking on it and choosing “Edit

Range”.
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This is the standard date range selector where you can choose either a range

based on the current calendar, or choose a specific calendar and choose a relative

or date range.
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You can even show data for multiple ranges. Here we’re showing the data for the

current month as well as the data for the month one year earlier.
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While scorecard items have a built-in repeating by calendar period, datasets and

initiatives do not. In this dataset example, we have a single bar showing the total

sales dollars for all time.

Repeating values aren’t required for datasets, but they are very useful. Here we’re

going to the Repeat panel and choosing to repeat by the Sales Employee field.
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We now have a separate bar showing the all-time sales totals for every employee.

Whenever the dataset is updated to include new employees, they’ll automatically

show up in this chart.

Repeating again

You can choose to repeat your data series a second time. To do this, click on the

“Repeat again by…” button and choose a field. Here we’re going to choose Sale

Date.
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The chart is now showing the sales totals for the last two months for all

employees.
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Repeating non-axis charts

Repeating works the same for non-axis charts. In this example we’re repeating

three KPIs for four calendar periods. By default, each calendar period is its own pie

chart, but you can change this by clicking on the calendar period range and

choosing “Edit Range”.
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For non-axis charts there’s a “Treat Range As” toggle, allowing you to show one

chart for the entire range.
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The result is this single pie chart that shows four periods of data.
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Grouping similar date ranges

In addition to graphing standard date ranges like all the months in 2021, you can

also graph data like months of the year or days of the week. In this example we

have two identical data series for Product Revenue, and we’ll choose “Edit Range”.
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We’ll change to “Group Similar Date Ranges” and then choose to group yearly

data by monthly.
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When we’re done, we see a completely different kind of graph. As you can see, it

now lists the months across the X axis but no years. Our chart now shows product

revenue for the current year compared against product revenue for the previous

year.
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Every scorecard data series has a “Set Period” menu item. This only shows up

when you’ve chosen to “Group Similar Date Ranges” and it allows you to choose

which period to use for each data series. That’s how we choose Product Revenue

for this year vs. last year.
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There’s no “Set Period” menu item for datasets. Instead, you can just choose which

date range you want as a filter in the “Set Data Source” menu.

Bar and area stacks

You can create bar or area stacks by choosing them from the “Add Analytics” menu

on either the left or right axis.
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This adds an empty stack to the axis.



USING SPIDER IMPACT 259

All you need to do is drag and drop data series into the stack. Here we’ve added

book and training revenue to the stack while product revenue is its own bar. This

allows you to have multiple stacks and non-stacked bars at the same time.
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You can configure the stack by clicking on it. By default, 100% height is off, and

you can see how the Y axis goes up to $1M.
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When we turn on the 100% Height toggle, the Y axis changes to percentages and

all repeating stacks become full height.

You can also change between Bar and Area stacks.
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Trend lines

You can add a trend line from each axis’ Add Analytics menu.

We now see a trend line object in the left axis panel. There’s also a trend line

showing each month’s average of the three series.
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You can change the line’s color.

You can also set its data source. Here we’re changing it to Product Revenue rather

than All Data.
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The chart now looks like this.

Trend lines have an optional fill above and below. Here we’re filling red above the

yellow trend line.
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Here we’ve turned off the display of the line and are showing a red fill above the

trend and a green fill below.
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Reference lines and bands

You can add reference lines and bands from the Add Analytics menu for an axis.

There are several pre-configured lines and bands to choose from, but in this

example we’ll choose a blank Reference Lines and Bands item.

This adds a Reference Lines and Bands item to the axis.
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We’ll click “Add Line” and then set the data source. First, we’ll choose to show each

scorecard item’s goal.

The chart now looks like this. There’s a goal line on every bar that we’ve made

green, and we’ve chosen “Goal” for the line’s label.
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Let’s see what a different data source looks like for the line. Here we’ll choose a

constant number of 300,000.

After changing the line color and label, it now looks like this.
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You can add as many lines as you want, each with its own data source. Here we’ve

added a second orange line, this one at 500,000.
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There are optional fills above, below, and between lines. Here we’re setting the

middle fill to orange. A fill between two lines is also called a band.

You can even turn off the display of the lines to just show the fill.
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Finally, we’ll change the line to show the average of all data series.

By default, the scope is the Entire Chart, so you’ll see a single line across the entire

chart.

When we change the Scope to “Calendar Period”, however, you’ll see the chart is

now only averaging the series inside of each calendar period, with a separate red
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line for each. Notice how the red line jumps slightly from period to period.

Forecasting

Line data series have a “Show Forecast” toggle.

When forecasting is turned on, Spider Impact will show predictions based on

historical values. The area around the predicted line is the confidence interval.
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By default, the confidence interval is 95%, meaning that based on the data

provided, the line has a 95% chance of being in that shaded region in the future.

You can change this to 90%, 99%, or turn it off all-together.

Here’s an example of Spider Impact detecting a seasonal trend.
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Here’s a non-seasonal positive trend example.

Here’s an example of no trend.
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You can tweak the forecast settings by choosing “Set Forecast Model”.

The default forecast model is Auto, and it’s often all you’ll need. You can also

choose to ignore recent days, which is helpful for data sources where recent data is

still in flux.
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When the model is set to Auto, Spider Impact tries out several algorithms and

chooses the best fit. If it doesn’t detect a trend, it uses Simple Exponential

Smoothing. If it detects a trend but no seasonality, it uses Holt’s linear trend (also

known as Double Exponential Smoothing). If it detects seasonality, it uses the

Holt-Winters model (also known as Triple Exponential Smoothing). Both trend and

seasonality are additive, as opposed to multiplicative.

If you prefer to choose the algorithms yourself, you can definitely do that. Auto

Without Seasonality just means it prevents Spider Impact from detecting

seasonality.
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When you choose a Custom model, you can choose Ignore or Additive for trend

and season. If you choose Additive for season, you can also choose if your

seasonality is quarterly, yearly, etc.



USING SPIDER IMPACT 278

Chart data table

To add a data table to a chart, turn on the “Show Data Table” switch in the chart’s

Other panel.
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On dashboards, the data table is separately configurable with options to adjust

the font and margin sizes.
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Geographic Maps

Creating a map

You can create interactive geographic maps in the Charts section that visualize

your geographic datasets data.

When you choose “Filled Map” for your new chart type, Spider Impact creates a

map with sample data. This sample data is the same as every other chart type,

and it allows you to explore the functionality without needing to hook it up to data

first.
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Map levels

Maps show data from datasets that have geographic fields. The sample data

shown by default is made-up numbers for every country. When you click “Map

Levels” you can choose which levels of the geographic hierarchy you want to show

on your map. Here we’re seeing 2D Earth broken into countries because those are

the two levels that are turned on.
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This is what it looks like when you turn on the Continent level. Our starting view is

now the 2D Earth view broken into continents because those are the two highest

levels that are turned on.
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Next, we’ll turn on the 3D Earth level. You can’t have both 2D and 3D Earth, so the

2D Earth level automatically turns off. We can now see a 3D globe that slowly

rotates on its own until you interact with it.

When you go to the Charts View tab, the map automatically resizes to fit available

space. You can hover the mouse over a region to see its value in a tooltip.
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When you click on a region, you’ll see a zooming animation and then that region in

more detail. This Country level is the lowest map level we have enabled, so we

can’t drill down any further. You can click the Back button to zoom out to the

world map.
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Map data

To show your real data on a map you need to first choose Set Data Source in the

Data menu.
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The data we’re choosing here is what numbers and colors you want to show up for

each map region. In this example we’re going to choose the Customers dataset

and “Number of Records” for the field. That means our chart numbers and colors

are going to be the number of customers in each region.

Next we need to choose a geography field in the Customers dataset.
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In this example we’ll choose the Postal Code field.

The map is now colored by the number of customers in each region.
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When we change to the Charts View tab and hover over California, we can see

that we have 5,804 customers there.
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Clicking on California zooms to the state level and now colors the postal codes.

This example shows how postal codes don’t always completely cover a state,

especially in rural areas.
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Starting view

The Starting View for maps is Auto by default. That means it starts showing the

lowest map region that contains all of the data. In the customers example above,

the view automatically started at the United States because all of the records in

the Customers dataset were in the US.
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You can choose a specific region to start on, though. Here we’re choosing the US

state of New York as the starting view.

Now when we first view the chart we’ll see all of the postal codes in New York. This

map also has the Country level turned on, however, so there’s a Back button to
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take us out to the country level.

Map colors

You can change the map’s colors by choosing “Filled Map Colors” in the Other

menu.
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By default maps use a light yellow to dark purple gradient broken into 6 segments.
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You can change the color scheme and number of segments, however, as well as

manually set the thresholds between color segments.
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Here we’re showing the number of customers in an 11-segment blue color scheme.
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Maps on dashboards

Maps, like all types of charts, work great on dashboards. Here we’re showing our

customer map with speedometers and a dataset table widget.
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Clicking on either a map region or the dataset table widget will apply a dataset

filter for that region to the entire dataset.
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Reports

Overview of Reports

The Basics

Reports show information about many Scorecard items, Initiative items, or

Dataset records at once. They have formatting, grouping, sorting, filtering, and

aggregating. In short, Spider Impact now has a full-featured report designer for all

of the data it tracks. For example, you can choose to view all of the downward

trending KPIs, all of the initiatives owned by a particular person, or aggregated

data about every Canadian employee.

Creating a report

To create a new report, click the “New Report” button in the Reports section.

Each report is for a single type of data. First, we’ll choose Scorecards.
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You can choose between several pre-built reports like the Red KPIs report and

Missing KPI Values report. These reports get you started with “canned” reports

that you can configure. See the Prebuilt Scorecard Reports article for more

information.

Instead, we’ll build a report from scratch by choosing the Advanced Report

Designer option on the bottom.

https://support.spiderstrategies.com/hc/en-us/articles/360041720091
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The Advanced Report Designer for scorecard items starts by showing the

scorecard item name, owners, and three periods of data for all KPIs.
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Let’s start a new report, and this time we’ll choose Initiatives.

A new Initiatives report starts with showing the budget and schedule information

for all non-archived initiative items.

The third type of report is Datasets.
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A dataset report shows data from a single dataset, which we’ll choose next.

Dataset reports are a little different from Scorecard and Initiative reports because

every dataset field is unique to each dataset. Because of this, dataset reports

start blank.
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Finally, users with the right permissions can choose SQL reports.

This allows them to write SQL queries against a database that you have set up in

Admin > Import Connections. For more information, see the SQL Reports article.

https://support.spiderstrategies.com/hc/en-us/articles/360041612811
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The View and Edit tabs

Regardless of whether you’re writing reports for Scorecards, Initiatives, or

Datasets, the general flow is the same. The Reports Edit tab always shows the

first three records so you can get a preview of what your report will look like.

 

When you switch to the View tab, you’ll see your entire report.
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Column Sorting

When you're viewing a report, you can temporarily change the sorting by clicking

on the column headers. See the Building Reports article for information about

setting the default sorting.

https://support.spiderstrategies.com/hc/en-us/articles/4408579703572
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Prebuilt Scorecard Reports

When you choose to create a Scorecard report, the first 8 report options are

prebuilt reports to quickly show you relevant data. Most of these "canned" reports

are built on top of the Advanced Report Designer and provide you with a great

starting point for further customization.

Scorecard Item Owner/Updater Report

The owner/updater report shows all of the owners and/or updaters for the

scorecard items you choose. The first step is to choose a scorecard item, and here

we’re choosing an entire scorecard.
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Next you choose what you want the report to show.
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When you’re done you see a report like this.
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Red KPIs Report

The Red KPIs report is probably the most popular report in Spider Impact and

shows you all of your underperforming KPIs. The first step is to choose a scorecard

item. Here we're going to show all red KPIs for the entire Mobileworld scorecard.

You then choose your display options. Most of the time the defaults will work just

fine.
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When you click Finish you'll see a report that looks like this:
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Missing KPI Values Report

The Missing KPI Values Report shows you all KPIs that haven't been updated for a

particular time period. To start, you need to choose a scorecard item. Here we're

going to run the report for the entire Mobileworld Scorecard.

Next you choose your display options. The defaults work great most of the time.
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When you're done you'll see a report like this:
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Annual KPI Data Report

This is similar to the data shown on the Scorecards KPIs tab. The first step in

building the report is choosing which scorecard item you want to show the KPIs for.

The next step is choosing what data should be shown on the report. The defaults

only show the actual values and yearly totals.
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When you're done you'll see a report that looks like this:
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Scorecard Structure Report

The Scorecard Structure Report doesn't show any kind of performance data. It's

all about the structure of your scorecard. To build the report, first choose a

scorecard item. In this example we're going to choose an entire scorecard.

Then you choose what information you want to show. By default it doesn't include

any of these extras.
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When you click Finish you'll see a report that looks like this.
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KPIs by Calendar Report

The KPIs by calendar report shows you all of your KPIs that match a particular

update frequency. First we'll choose the entire Mobileworld Scorecard.
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Then we'll choose which calendars we want. In this example we'll choose Monthly.
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When we click Finish it shows a list of all monthly KPIs in that scorecard.
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KPI Comparison Report

The KPI comparison report is used to compare organizations that have similar

KPIs. The first step in the wizard is to choose which organizations you want to see

in your report. You can either select each organization one at a time, or you can

automatically include an organization’s descendants.

Once you’ve selected your organizations, the next step is to choose your KPIs. Here

I’ve selected the scorecard root, which will automatically include all of the KPIs.
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When we’re done we see a report with all of the KPIs for each of the four selected

organizations.
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Scorecard Attributes Report

The Scorecard Attributes Report doesn't show any performance information.

Instead, it shows you information like the owners, updaters, and KPI frequency of

multiple scorecard items at once. To run the report, all you have to do is choose a

scorecard item. Here we've selected the entire Mobileworld scorecard.
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When we click Finish, we see a report that looks like this:
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Building Reports

Adding and reordering columns

To add a new column, click the “Add” button where you want the new column to

go.

This brings up a list of all available fields from which to create columns. Here you

can see the placeholder where the new column will go, right before we click to add

the “Data Type” field as a column.
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Immediately after the new column is added, the “Add Column” tooltip stays open,

and you can see a new placeholder column to the right of the new column. This

allows you to add multiple columns quickly with a few clicks.

To change the order of columns, you can just drag and drop them to where you

want them to be.
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Row filters

Most reports will contain at least one row filter. The idea here is that you're

choosing which scorecard items/initiative items/dataset records you want to

show. In this example we've created a new scorecard item report, and there's

already a filter to only show KPIs. Let's add a new filter by clicking the "add"

button.



USING SPIDER IMPACT 327

The default row filter is "Specific Scorecard Items" and we'll use that here.

This allows you to manually choose which scorecard items you want to see. We’ll

add the entire “Mobileworld Balanced Scorecard” and click Done.
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Now we only see the two of the KPIs in the Mobileworld Balanced Scorecard.
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To edit a filter, just click on it. This opens the same dialog we saw before, and this

time we'll choose to make this an OR filter.

Now we see all scorecard items that are either KPIs or in the Mobileworld balanced

scorecard.
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Setting column labels

To edit a column, just click on it. You’ll see the column that you’re going to edit

highlighted, and it shows a tooltip with your editing options.
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In this example we’ll click the Edit button, and we’ll choose “Set Column Label.”
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This opens a dialog where you can choose to override the Default column label and

type a value of your own. In this example we’re going to change the “Sale Price”

label to “Value.”

Here’s what the report looks like with the new column label.
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Editing column data

Every report column gets its data from somewhere, and to edit what data is

showing, choose “Set Data Source” from the Edit Column menu.

The default column type is Basic. This means the column is showing the value for a

single field.
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You can also choose to show a Calculated value in a column. Here we’ll change the

Type to Calculated and we’ll click the “Set Equation” button.
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In this example we’re building an equation that shows the value of the “Sales Price”

field, but with an additional 7% sales tax added if the value of the Country field is

“United States.” For more information, see the Equations article.

Finally, it’s important to note that you can reach this “Set Data Source” menu

when adding a new column. Most of the time you’ll want to choose a field from the

list when adding a column. But, if you know your new column is going to be more

complicated than that, you can just click the “More Options button that’s in the

“Add Column” tooltip.

https://support.spiderstrategies.com/hc/en-us/articles/4407643362452
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This shows the same “Set Data Source” menu, but this time it’s for a column that

hasn’t been created yet.
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Show values for

Sometimes when you click on a column, you’ll have a “Show Values For” dropdown.

In this example we’ve clicked on a date column that’s showing data from the Sale

Date field, and we’re currently showing “Every Sale Date”.

Here we’ve chosen to show values for the Quarterly calendar. The column now

shows which quarter the sale happened in instead of the specific date.
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You’ll see other options in the “Show Values For” dropdown depending on what

data your column is showing. For example, our dataset has four ranges set up for

the Sale Price field.
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When we click on the column showing the Sale Price field, we can see that it

defaults to “Every Sale Price”.
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If we change “Show Values For” to “Every Sale Price Range”, we’ll see values that

look like this.
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Column formatting

To edit a column’s formatting, choose “Edit Formatting” from the Edit tooltip.

The Edit Formatting dialog gives you a preview of what your formatted data will

look like. Here we’ve changed the font size to large, changed the color to dark,

abbreviated the data, and aligned everything right.
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We end up with a report that looks like this.
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Column sorting

You can choose to sort on any field in your report. The default sorting for scorecard

and initiative reports is first by organization, and then by tree order. You can

change this default sorting by clicking on a column and turning on “Sort using this

field.”

You can then choose to sort that column ascending or descending.
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Grouping

You can group by a column by clicking on the column and turning on the Group

switch.
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This shows all unique values for that column as large group headers, and then lists

all of the records with that value underneath. In this example we’ve grouped by the

Sales Employee column, so each group is a different sales employee. The Edit tab

only shows the first three groups, but switching to the View tab will show the full

report.
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You can create another level of grouping by selecting another column and turning

on “Group Again”.
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In this example the Sales Employees are also grouped by Sales Department.
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Hiding individual records

Adding a group to your report opens the door to many new data presentation

possibilities. The most powerful is the ability to turn off “Show Individual Records”.

In this example, we’re grouping records by the Sales Employee column, and we’re

showing columns for the Sale Date, Sale Price, and Sales Department.



USING SPIDER IMPACT 349

When you turn off “Show Individual Records”, the report now only shows the

groups. As you can see, the columns remain the same, but now they’re showing

aggregated data for each group. Number columns like Sale Price are summed by

default. The default aggregation type of Date and Text columns is counting the

number of unique values.



USING SPIDER IMPACT 350

Let’s say we want to show the Average sale price for a group instead of the Sum

of all sale prices. To do this, just choose Set Data Source like we did before.
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Now that we’re showing aggregated data, however, we have an Aggregation Type

choice in this dialog. We’ll choose Average.

Once we click Done, we have a report showing the average sale price for each

employee.
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Finally, we’ll change the Sale Date aggregation type to “Latest Date”. Our finished

report looks like this on the Edit Tab.

And like this on the View tab.
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Column filters when hiding individual records

Once you’re hiding individual records and your report is showing aggregated data,

you can start adding filters to your columns. In this example we’re going to choose

“Set Data Source” for a Sale Price column.

We’ll leave the aggregation type as sum and click the “Add” button in the filters

panel.
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Next, we’ll create a filter to only include data from records where the sales country

is Canada or Australia.
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This is what our new column filter looks like.
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When we click Done, we now have a column showing the sum of all sales in

Australia and Canada for each employee.
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Repeating columns for scorecards

You can create repeating columns for Scorecards, Initiatives, and Datasets reports,

but they’re a little bit different for every report type. For Scorecards, values that

change over time are always inside of a repeating column. Whenever you add a

column like KPI Value or Goal, you’ll automatically see that field repeating by

calendar period. As you can see in this example, it doesn’t make sense to show a

KPI value without knowing what period that KPI value is for.

To edit repeating columns, just click on them. Just like when you select a column,

selecting a repeating column header shows a tooltip. We’ll click the Edit button.
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This opens the Edit Repeating Columns dialog. We’ll change the calendar to

Quarterly, and we’ll choose a range of 4 periods.

When we click Done, we now see the KPI value being repeated for four quarters.
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Repeating columns for initiatives

As we mentioned above, repeating columns work a little differently for every

report type. Repeating columns for Initiatives are similar to repeating columns for

Scorecards because there are values like Money Spent that change over time.

Initiatives are different, however, because their repeating columns aren’t required

and aren’t added by default. Whenever you have a column for a field that changes

over time and it’s not repeating, the report will just show the latest value.

In this example we have a column showing the projected budget variance for every

initiative item. The projected budget variance field does change over time, but

because this column isn’t inside of a repeating column header, the report just

shows the most up-to-date values for the projected budget variance. We do,

however, see a “Repeat this column by calendar period” button.
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When we click the button, we now have repeating columns showing how the

projected budget variance has changed over time.



USING SPIDER IMPACT 361

Repeating columns for datasets

You can only add repeating columns to dataset reports when individual records are

turned off. That’s because we need to first aggregate dataset records for each

group before we can disaggregate the data into repeating columns. Scorecard and

Initiative reports don’t have this restriction because their repeating columns can

show values that change over time.

In this example we’re grouping by Sales Employee and are hiding individual records.

We now see a “Repeat this column by…” button when you click on any column other

than the one you’re grouping by.

We’ll click the “Repeat this column by…” button and then choose to repeat by

Country.
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We now have a separate Sale Price column for every country.

Multiple blocks of repeating columns

You’re not limited to one range of repeating columns. In this example we’re going

to add a new column outside of the first block of repeating columns.
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We’ll choose to add another KPI Value column, and now we have two identical

blocks of repeating columns.

Finally, we’ll edit each repeating column block to contain a single period, and we’ll

drag and drop the blocks next to each other. Now we have a report showing the

KPI value for the current month and the KPI value from the month one year ago.
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Repeating columns again

Scorecard, Initiative, and Dataset reports can all repeat columns a second time

when individual records are turned off. For Scorecard and Initiative reports,

repeating again is almost always used when multiple organizations have the same

initiative or scorecard items and you want to compare them across organizations.

For datasets, repeating again is common with all field types.

To repeat again, click on the repeating column header to select it.
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Then click “Repeat again by” and choose a field. Here we’ll repeat by Sales

Department.

The result is a report with two levels of repeating columns, first by Sales

Department and then by Country.

On the Edit tab there are all 0s for Corporate sales, but when you go to the View

tab you can see that in this example employees either sell retail or corporate, never

both.
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Changing header order

In this example we’re showing KPI Value and Goal columns, repeating for 3 periods.

The columns are on the bottom and the calendar periods are on top.

To put the columns on top, just drag and drop them vertically.
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Now the report first groups by column, showing the three periods for KPI Value

and then the three periods for Goal.

Hiding repeating column headers

Some reports have only one column, for example KPI Value. Other reports have

only one repeating value, for example a single calendar period. In these situations,

you can choose to hide either the column or the repeating value header.

For example, here we’re showing the KPI Value for three months. The KPI Value

isn’t adding a lot to the report in this situation, so we’ve dragged the column

header to the top.
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We then select the column and turn on “Hide This Header”. On the Edit table the

header now has an icon showing that it’s hidden.

On the View tab the column header is no longer visible.
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When you’re repeating again, you can even hide two levels of headers. In this

example we’re showing data for a single field and for a single calendar period.

We’ve chosen to hide all of the headers except the KPI name.

Notes columns

When you add a notes column to your report, there’s a “Set Note Display” option in

the menu.
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This allows you to choose not only the type of notes to show for your report, but

also the information from each note you want to see.
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Weight columns

A scorecard item’s weight can change over time, but it often doesn’t. If you add a

Weight column to your report, it will show the most recent weight for that item.
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If you add a Weight column inside of repeating calendar periods, it will show what

the weight was at the end of the period. In the example, the “SEO Project Spend”

KPI weight changes in August.
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SQL Reports

Basics

SQL Reports allow you to write raw SQL against a database that you have set up

in Admin > Import Connections. To create a SQL report, click the "New Report"

button.

If you have the correct permissions, choose SQL for the report type.

And write SQL against the database.



USING SPIDER IMPACT 374

SQL reports appear the same as other reports, except they can’t have advanced

formatting.
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Example SQL

You can include the following text in your SQL queries.

[calendar-period-id]

[calendar-period-start]

[calendar-period-end]

In this example we’re referencing both the calendar period start date and end date

to see all of the failed logins during the current period.

Here are the report results for August 2019. You can see there were three failed

logins.
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When you change the calendar period selector to September 2019, the SQL report

shows different results.
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Datasets

Overview of Datasets

Overview

Spider Impact tracks three types of performance data.

�. Scorecards measure the same things over and over. They’re all about setting

goals for KPIs, and then using that information to see how you’re performing

with your big-picture strategy. The KPIs you measure this year will usually be

the same KPIs you measure next year.

�. Initiatives are temporary. They have start and end dates and usually last less

than 18 months. You put initiatives in place to fix the problems you find in

the Scorecards section.

�. Datasets track unstructured raw data that isn't scored. They’re the business

intelligence layer underneath your strategic management. You can analyze

and report on dataset data directly, and you can aggregate dataset data to

power KPIs in the Scorecards section.

Here we'll focus on Datasets. We’ll cover how they’re used, and what makes them

such a powerful addition to Spider Impact.
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The Explore tab

The Datasets section is great for exploring your data and quickly answering

questions. It’s all about slicing and dicing your data on the fly to get the answers

you need immediately.

It’s important to keep in mind that the Datasets section is not a presentation tool.

It’s the place where you store and explore all of your data. When it’s time to show

your dataset data to other people, the Dashboards, Charts, and Reports sections

have everything you need.

Viewing and filtering fields

We’ll start with a Device Sales dataset. It contains information about the 29,085

devices our company has sold. At this point we don’t know much about the data,

so we’ll start to explore.

To choose a field to view, click on the field menu.

https://support.spiderstrategies.com/hc/en-us/articles/4408589452948


USING SPIDER IMPACT 379

This lists all of the dataset’s fields. As you can see, there’s information about things

like the sale date, the price, and the customer. We’ll chose Sales Employee.

This adds a table breaking down all of the sales in this dataset by sales employee.

Issac Bernhardt is in the lead with 5,717 sales.
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Next, we’re going to choose the Sales Date field in the main field menu. This adds

another table that breaks the sales down by date. As you can see, May 2021 was

our best sales month.
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If we want to see only the sales for May 2021, we can just click on that row in the

Sale Date table.

This applies a “Sale Date = May 2021” filter to all of the data on the screen. In the

upper right corner, we can see that the number of sales has been updated to 728.

All of the numbers in the Sales Employee table now reflect only May 2021 sales. To

remove the filter, just click the back button in the Sale Date table.

Although you can do advanced data exploration on the Datasets Explore tab, this

is what most of your analysis will look like. You choose fields to view, and then you

click on a row to filter.
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Exploring Dataset Data

Please see the Overview of Datasets article for information about what datasets

are, and how to add and filter fields on the Datasets Explore tab.

Advanced filters

At the top of the Explore tab you can see all filters that are currently applied to

the dataset. In this example we can see the “Sale Date = May 2021” filter that we

applied by clicking on the “May 2021” row on the bottom. Another way to add a

filter is to click on the “Add” button in the corner.

Just for the sale of this example we’ll only show sales employees that have an “O”

in their names.

https://support.spiderstrategies.com/hc/en-us/articles/4408591440404


USING SPIDER IMPACT 383

The results of the filter are the same as before, except now we’re only showing

data for four of the sales reps.
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Changing total display

Seeing the total number of sales is interesting, but what we probably care the

most about is the total value if the sales. The quickest way is to change the total

display in the upper right corner.
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We’ll change the display from “Number of Sales” to “Custom Field”, choose “Sale

Price” as the field we want to see, and “Sum” for the aggregation type.
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The sales price tells a completely different story. We now see that Kym Lavender is

our top salesperson with $6.1M in total sales, and that July 2021 was actually our

top sales month by revenue.

In this example, sale price is obviously better than the number of sales, so we’re

going to go to the Edit tab and change the “Defaults for Total Display”.



USING SPIDER IMPACT 387

We can make the change from “Number of Sales” to “Custom Field” so that next

time someone explores the Device Sales dataset it will default to showing Sales

Price.

Choosing columns

Another way to change the data being displayed is to manually choose a table’s

columns.

We’re going to add an Average Sale Price column to the Sales Employee table to

figure out why our employee rankings changed so much when we switched from

number of sales to total sales value.
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Sure enough, Kym and Russel had average sales around $18,000 while everyone

else was averaging less than $700.
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Repeating rows and columns

Here’s a simple table showing the sum and average sales price by month.

We want to see those numbers by sales department, however, so we’ll choose

“Repeat Rows By…” from the options menu.

And we’ll choose the Sales Department field.
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We can now see the sum and average sale price for each of our two sales

departments for every month.

Similarly, you can also choose “Repeat Columns By…” In this example we’re

repeating the sum and average sales columns by salesperson.
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Saving views

As mentioned earlier, the Datasets section is not meant to be a presentation tool.

There are times, however, when you’ll want to save the tables and filters that are

on the Explore tab so you can view them later. All you need to do is click the Save

button on the bottom…
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Give the Dataset View a name…

And it will add your saved view underneath the dataset in the navigation pane.

You can use dataset views as starting points for further data exploration, and

they’re shared by everyone who uses the dataset.
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Creating and Editing Datasets

Creating a dataset

To create a new dataset, click on the “New Dataset” button at the top of the

navigation pane.

This brings up the new dataset dialog. The “Dataset Name” is what you want to

call your dataset, and it shows up in the navigation pane on the left. The answer to

“Individual Records Track” should be the plural form of one row of your data. In this

example, we’re tracking device customers, so we’re entering “Customers”. Finally,

we can either get data from a database or spreadsheet, and we’re choosing

spreadsheet.
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You can build a dataset from either a spreadsheet or a database. In this example

we have a spreadsheet containing information about each of our customers that

looks like this. Notice how each customer has a Customer ID in the first column.
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There are multiple options for where to get spreadsheets. To fully automate your

data flow, you can schedule an import from Google Sheets or an (S)FTP server. If

you want to build multiple datasets from the different worksheets in an Excel file,

you’ll probably want to store a single file in the Files section and build your

datasets from that. See the Updating Datasets article for more information.

For now, we’ll just keep it simple and upload a file.

https://support.spiderstrategies.com/hc/en-us/articles/4408581928468
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Once the spreadsheet is uploaded, Spider Impact starts to scan and process it.

This may take anywhere between a few seconds and many minutes, depending on

the size of your data.

When it’s done processing, the next step is to choose the header row that contains

the column labels. If you’re using an Excel file with multiple worksheets, you’ll

choose which worksheet you want to use on this step too.
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The data transformation step is next, and it allows you to apply powerful

transformations to your data as it’s imported. You can skip records, combine fields

together, or clean dirty data.

https://support.spiderstrategies.com/hc/en-us/articles/360041132552
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Finally, you choose which fields you want to include in your dataset. This is your

first opportunity to choose a better name or data type for each field, but you can

always edit fields on the Edit tab later.

In this example we’re also setting Customer ID as the primary key, which allows us

to update records later as well as link datasets together.
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After you click Done it can take several minutes or longer for your dataset to build,

depending on the amount of data.
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Editing datasets

To edit a dataset, just go to its Edit tab. Here you can modify several things that

you set up when initially building the dataset.

�. The dataset name that shows in the navigation pane.

�. Used throughout the app to identify what is stored in the dataset, for

example the total box.

�. The primary key field.

�. The data source.

�. Optional data transformations.

�. Upload a new spreadsheet. For connections to Databases, Google Sheets,

and (S)FTP this will be a “Fetch Data” button to pull in the latest data.

�. Download the most recently imported spreadsheet.

Editing fields

You can edit dataset fields on the Edit tab by clicking on their edit buttons.
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This opens the Edit Field dialog.

�. The field name

�. The field’s data type, for example Text, Date, Number, Etc.

�. A Basic field is simple, it’s just one column of data. You can also create fields

that are Calculated or Data Clusters, which are covered below.

�. The column to use for the basic field.
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�. Hide From Non-Administrators allows you to prevent a field from showing in

Spider Impact. For example, if you’re you’re using a private ID number to link

multiple datasets together, you could use that field for linking on the Edit

tab, but choose to hide that field everywhere else.

Dataset rebuilding

There's a "Rebuild Dataset" button that rebuilds a dataset with the same data it

had before. If you run into an unexpected problem, sometimes manually forcing a

rebuild can fix it.

Datasets also rebuild automatically whenever you add or edit one of its fields, or

when you edit a field used by one of its calculated fields. This rebuild is the same as

the initial build described above, except that the dataset is completely usable while

it's being rebuilt. Users will continue to see the old data until the new data is ready.
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Other situations that cause a dataset to rebuild are updating dataset records and

editing rollup trees. Renaming fields or changing a dataset's permissions do not

trigger rebuilds.

Field groups

Field Groups allow you to organize your fields into groups. Here we’re creating a

“Point of Contact” field group and adding several fields to it.

https://support.spiderstrategies.com/hc/en-us/articles/4408581928468
https://support.spiderstrategies.com/hc/en-us/articles/4408581972116
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Now whenever we see a list of fields for this dataset, the Point of Contact fields

will be grouped together.
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Field categories and ranges

When we add the Sale Price field to the Explore tab, it lists every single unique

price in the table. This isn’t particularly helpful because the most common sale

price of $411 only appeared on 6 sales.

To fix this, let’s visit the dataset’s Edit tab, scroll down to the Fields table, and click

on the Sale Price field’s Ranges button.

To add a range, click on the add button in the corner.
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Then we’ll create our first range. In this example, the “inexpensive” range is

anything less than $400.

Then we’ll add three more ranges.
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Now when we explore Sales Price, it defaults to showing the four ranges we

created. This is much more usable information.

At any point you can switch back to showing every sales price.
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Fields with data types like Text have categories instead of ranges.

The idea is the same, but you choose specific values for every category. Note how

in this category we’ve also included blank values.
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Dataset Equations: Fields and Filters

Calculated dataset fields

You can build dataset fields that are calculations based on other dataset fields.

This includes fields in other datasets. To do this, we’ll click the “Add” button in the

Fields panel on the Datasets Edit tab.

This opens the Add Field dialog. We’ll choose Calculated for the type and we’ll click

“Set Equation”.
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Now we can build the field’s equation by choosing dataset fields on the bottom,

clicking the “add” button to add them to the equation panel above, and by typing

text directly in the equation panel.
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In this example, we’ve got a Customers dataset and we’re building a calculated

field to track the customer’s name. The equation says to use the “Company” field

for the customer name if it’s not empty. If there’s no company specified, use a

combination of the point of contact first and last names.

if([Company] != "",[Company],[POC First Name] + " " + [POC Last Name])

Once we build the calculated field, it is listed with all of our other fields in the

Fields panel.
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Here’s our new customer name field on the Records tab.

For information about all of the functionality that equations support, please see

the Equations article.

Filter equations

Dataset filters are used throughout Impact. For example, here we’re on the

Datasets Explore tab seeing all 29,085 total records. We’ll add a filter by clicking

on the “add” button in the Active Filters panel.

https://support.spiderstrategies.com/hc/en-us/articles/4407643362452
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The “is any” filter allows you to choose specific field values. In this example we’re

showing records where the Sales Employee is “Delphine Calmes”. You can also click

the “add equation” button.

This opens a dialog where you can build an equation to match field values against.

In this nonsense example, we’re matching records where the sales employee field

matches the sales department field with “ test” added to the end.
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Here’s what our filter looks like when we’re done.

You can write equations against more than just text. In this example we’re adding

an “after” filter to the Sale Date field.
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On the next step of the wizard we’ll change the date to calculated and click the

Set Equation button.

We can build an equation to compare the Sale Date against another date field,

but instead we’re going match all dates in the past year.
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Here’s our new filter in action, showing only 6,595 matching records.
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Updating Dataset Records

Manually importing

If you’ve created one or more datasets from a spreadsheet in the Files section, it

will list those datasets on the file’s Overview tab. Whenever you upload a new

revision to that file in the Files section, Impact will automatically update the data

in the corresponding datasets.

If a dataset was built by directly uploading a spreadsheet, you can update the

dataset by uploading a new version of the spreadsheet on the Dataset Edit tab.
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You can download a copy of the dataset’s most recently uploaded spreadsheet

there too.

Scheduled imports

You can schedule imports for datasets that are built from databases, Google

Sheets, or (S)FTP spreadsheets. See the Managing Imports and Connections

article for more information.

To set or modify an import schedule, you can go to either the Administration >

Imports screen or the Datasets Edit tab. Here we’re clicking the edit button for a

scheduled import.

https://support.spiderstrategies.com/hc/en-us/articles/360041568531
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In this example we’re importing from Google Sheets on the first day of every

quarter at 7:00 PM.

Add records vs. replace all records

The default behavior when importing new dataset data is to keep the existing

records and add new ones. If your dataset has a primary key and a new record’s

key matches an existing record, the old record will be replaced. The “Add Records”

option is used when the data you’re importing represents transactions rather than

all source data.
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You can also choose to replace all records, which is used when the data you’re

importing represents all of the data from the system of record. All existing records

will be removed, and all new records will be added. This is actually the most

common option, but it does mean you lose your old data, so it’s not the default.



USING SPIDER IMPACT 423

If you accidentally add records instead of replacing them, don’t worry. You’ll notice

the problem because you’ll have more records than expected. All you need to do is

re-import the data and choose “Replace All Records”.

It’s also important to note that regardless of whether you’re adding or replacing all

records, any custom changes you’ve made to data on the Records tab will not be

replaced. New records that you’ve created, and any overrides you’ve done, will be

mixed in with your newly imported data. See the Manually Adding & Updating

Records article for more info.

There are multiple ways to get to the import behavior choice. As shown above,

you’ll see it whenever editing an import’s schedule. You’ll also see it whenever you

manually upload a file. Finally, you’ll see it whenever editing the dataset’s data

source.

https://support.spiderstrategies.com/hc/en-us/articles/4408588410388
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Dataset rebuilding

As described in the Creating and Editing Datasets and Dataset Rollup

Trees articles, datasets automatically rebuild whenever you edit one of their fields,

or edit a rollup tree that they're using. Datasets also rebuild whenever you update

their records or you update the records of any dataset referenced in their

calculated fields.

Rebuilding after updating records isn't noticeable because users still see the old

data while the dataset is rebuilding. There's just a small notification on the

Datasets Explore tab.

https://support.spiderstrategies.com/hc/en-us/articles/4408587064980
https://support.spiderstrategies.com/hc/en-us/articles/4408581972116
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Dataset KPIs

Creating a dataset KPI

To create a KPI from dataset data, click on any number on the Datasets Explore

tab, and then click the “Create Dataset KPI” link. In this example we’ll click on the

$3.6M of total Canadian sales.

Here you can choose to create a new KPI or add data to an existing KPI. We’ll

choose to create a new KPI and we’ll name it “Canada Sales Value”. We’ll also

choose the Sale Date for the calendar field, and we’ll find a good place for the new

KPI to go.
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After saving the new KPI, it looks like this. The $3.6M in total Canada sales has

been broken into months using the Sale Date field. In a few clicks we’ve created a

KPI with data going back years. Even better, whenever the dataset is updated with

new data, the KPI will automatically update.
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This dataset KPI is just like any other KPI, and we can give it thresholds if we want.
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Now our KPI has colors, and we can create performance alerts. When you hover

over the KPI value, you can see exactly where the data comes from.

If you click on the KPI value on the Scorecards Overview, you drill down to the

Datasets Explore tab for further exploration. Here we have the “Country =

Canada” filter automatically applied, with the date set to “June 2021”.
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Snapshot dataset KPIs

Let’s create another dataset KPI.

In the previous example we chose Sale Date for the calendar field, but this time

we’re not going to choose any date field. Instead, we’re going to make a new

snapshot KPI.
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Rather than spreading the $3.6M over time, it saves the entire value in the current

month of July 2021. Then, at the beginning of the next month, Spider Impact will

save whatever the total is at that time for August 2021. Over time the KPI will

build a performance history.
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Snapshot KPIs are often used when the data source doesn’t contain historical

data. For example, we may have an HR system that only contains information

about our current employees. If we had a “Number of Employees” KPI, we’d create

a snapshot that updates based on the total employees in our HR system.

Spider Impact manages all snapshot KPIs for you, but if you’re curious, here’s how

the process works.

Every day, early in the morning, Impact looks to see if a new calendar period

started. If so, it will create a new snapshot value. For example, if it's the first day

of the month, all monthly KPIs will get new snapshot values. Whenever the dataset

is updated with new data, it will also immediately update the current period for all

of its dataset KPIs. Finally, when an administrator manually rebuilds the dataset,

the snapshot KPI values for the current period are replaced.
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It’s important to note that Impact updates the data in the current period, not the

previous period. By default, however, Impact shows the previous period when you

log in. That means you’ll often have to move one period forward to see the latest

snapshot values.
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Dataset Permissions

Standard dataset permissions

Standard datasets permissions are the same as permissions in every other section

in Spider Impact. Administrators give dataset permissions to a group, and then

give that group permission to view organizations. If someone is in a group that can

see an organization, they can see its datasets. If someone is in a group with the

“Modify Standard Permission Datasets” permission and that group can see the

organization, that user will be able to modify all datasets with standard

permissions in that organization.

When you create a dataset, it defaults to using standard permissions. As you can

see on the Datasets Edit tab, “everyone who can see this organization can see this

dataset”.
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Advanced dataset permissions

There are times, however, when you don’t want people to see all of a dataset’s

records. For example, you may want to allow everyone who can see the

organization to only be able to see records where the “Restricted” field value is

“False”. Or you may want to limit a user to only see a subset of the records based

on a “Region” field.

For these datasets you can turn on Advanced permissions. When advanced

permissions is on, only the users and groups who have been given explicit

permission to the dataset can see it.



USING SPIDER IMPACT 436

The users and groups that you add in the Permissions panel will be able to see all

records by default, and they will only be able to view data. You can click on the Edit

button to change this.

Here we can give the user any of the permissions in the purple box, and they only

apply to this dataset. You can also add a permissions filter by clicking the add

button in the permission filters panel.

We’re going to add a filter for Sales Department = “Corporate”.
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When we’re done, the dialog looks like this. Dale Peterson can administer the

dataset, but he can only see records where sales department is corporate.
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When Dale logs in, he’ll see a permission filter permanently applied to every screen

that shows dataset data.
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Viewing without explicit advanced permissions

There are two notable exceptions to the rule that only users and groups who are

explicitly granted access can see advanced permissions datasets.

First is the “Modify All Datasets” permission. This is unchecked by default and

allows members of the group to modify all datasets that the group can see,

regardless of whether advanced permissions is on.

Second, you can add a user named “Everyone” when advanced permissions is on.

This allows anyone who can see the dataset to view its data, and by editing the

Everyone user’s permissions, you can restrict the records they can see or assign

actions that every user can do.
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Auditing dataset permissions

The default view for advanced permissions is “By User or Group”. This allows you to

see a list of everyone who can view the dataset, and you can edit their permission

by clicking on the edit button on the right.

Instead of viewing permissions “by user or group”, you can also choose to view

permissions “by permission filter”. This is helpful when auditing exactly what

people can see within the dataset.

The default view is showing users and groups that have any permission filters at

all. As you can see, there are two users and one group who have permission filters,

which means they can’t see all of the dataset records. Just like on the “by user or

group” view, you can click on the edit button on the right to see and edit their

permission filters.
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There’s also a list of users and groups who can view all records. It’s collapsed by

default.
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This gives us a good impression of what’s going on. There are two users or groups

who can view everything, and there are three users or groups who can view only

some records. We can take our permissions audit quite a bit further, though.

If we click the “Field” select, we can see all of the dataset’s fields that have a user

or group’s permission filter applied to them. In this example, “Country” and “Sales

Department” are the two fields with permission filters. We’ll choose Sales

Department.

We now see that Dale Peterson has a “Sales Department is Corporate”

permissions filter directly applied to him. We also see the collapsed “view all”

section with the same two users who can view all records. That means there are

three users in the software who can view corporate sales department records.
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You can also quickly assign other users and groups permission to see Corporate

sales records.

When we click the “Permission Filter” dropdown we see that users or groups also

have permission filters for the sales department being retail.
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By exploring your dataset permissions this way, you can quickly understand who

has access to what, and you can ensure that only the correct users have access to

sensitive data.
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Advanced: Linking Datasets

Creating links

You can unlock powerful insights by linking datasets together. In this example we

have two datasets. The first is information about our customers, including their

address and points of contact. The primary key is a Customer ID.

The second dataset is information about all of the sales we’ve had over time.

There’s a sale date, sale price, and the Customer ID of the organization who made

the purchase. In order to link the Customer ID field to the customers dataset, we’ll

edit the Customer ID field in the device sales dataset.
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We’ll change the field type from Text to Dataset Link and choose the Device

Customers dataset. This tells Spider Impact that the values for this Customer ID

field match the primary key values of the Device Customers dataset.

The Customer ID field is now a dataset link, so we’ll save the dataset.
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Fields from linked datasets

Our two datasets are now linked together and there is now a “Fields From Linked

Datasets” panel on both datasets’ Edit tabs. You can click the “Add” button to

choose which fields you want to appear from the linked dataset.
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In this example we’ll choose to add the Customer Country to the Device Sales

dataset.
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And we’ll save the dataset again.

We are now able to break down our sales totals by Country.
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Complex linking

Dataset links are bidirectional. Once a link is set up between two datasets, you can

set up fields on both sides of the link. In this example the “Fields From Linked

Datasets” panel now shows for the Customers dataset too.
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Linking isn’t limited to two datasets either. If several datasets are linked together,

datasets that aren’t directly linked can share fields.  You can even build calculated

fields using data from multiple linked datasets.
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Advanced: Dataset Rollup Trees

Using dataset rollup trees

Dataset rollup trees allow you to track hierarchical data. They’re great for

companies and governments that have large organization structures, as well as for

geographic data (Country > State/Territory > Postal Code).

In this example we have a military fitness test dataset with 333,000 records.

We’ve added the Unit Identification Code (UIC) field to the Explore tab, and we

can see that the W4K9AA organization has the most fitness test records in this

dataset.

Militaries are very hierarchical organizations, so we’re going to edit the UIC field

and turn it into a rollup tree.
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We change the data type from Text to Rollup, and then choose which rollup tree

we want. Rollup trees are build and managed in the Administration section, and

we’ll cover how to do that next. In this example we’re choosing Chain of Command.
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Now when you add the UIC field to the Explore tab, you see a tree instead of a list

of UIC. That’s because Impact has matched the UICs to items in the Chain of

Command rollup tree and is now able to show you aggregated totals. And, just like

every other field type, you can click on an item in the tree to drill down.
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At the top of the UIC panel it now shows the tree level that we’ve drilled down to,

as well as a back button that will take us to where we were before. As you

navigate up and down the tree, Impact automatically applies filters to restrict

records to only that tree level. In this example you can see the Gender panel

updating with new numbers as we go down the tree.
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Here we’ve drilled down to a third tree level. Most rollup trees are fairly small, but

Impact has been tested to perform well with trees as large as 50,000 items.

Managing dataset rollup trees

You can build and manage dataset rollup trees in the “Dataset Rollup Tree” page in

Administration. On the left is the rollup tree that you choose in the dropdown

above, and on the right, you can edit the keys for the selected tree item. In this

example, any time a field’s value is “WDARFF”, it will match with the “Dept of the

Army” item in the rollup tree.
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It’s most common for every item in the rollup tree to have a single key. Sometimes,

however, tree items will have no key at all and will instead be used only for showing

aggregated data from its descendants. Other times a rollup tree item will have

multiple keys.

Because rollup trees are used across multiple datasets, each dataset may have a

different way to reference the tree items. To support this, Impact allows you to

create multiple keysets. For example, one keyset may be “By Payroll ID” and

another keyset may be “By Human Resources ID”. When a rollup tree has multiple

keysets, you’ll also need to choose which keyset to use when setting up a rollup

tree field in your dataset. Keysets are important because different datasets can

use the same key to refer to different items.
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Just like other places in Impact, you can put the rollup tree in edit mode.

This allows you to drag and drop items to reorder the tree, and the selected item

has a tooltip menu on it for modifying tree items.
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To change the rollup tree that you’re editing, select the tree you want in the

dropdown in the upper left.

Next to that is the Manage Rollup Trees button.
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This opens a dialog where you can create, rename, reorder, delete, update, and

download rollup trees.



USING SPIDER IMPACT 461

Dataset rebuilding

As described in the Creating and Editing Datasets and Updating Dataset Records

articles, datasets automatically rebuild whenever you edit a field or update their

records. Most of this rebuilding isn't noticeable because users still see the old data

while the dataset is rebuilding. There's just a small notification on the Datasets

Explore tab.

This is exactly the same thing that happens when you add or delete items in a

dataset rollup tree. Any dataset using that rollup tree will be transparently rebuilt

behind the scenes while people continue to see the old data until the new data is

ready. Similarly, renaming a rollup tree item doesn't cause anything to rebuild.

There are more invasive changes you can make to a dataset rollup tree that cause

all datasets using it to not only be rebuilt, but also to become unusable until the

rebuilding finishes. These changes are:

Moving a dataset rollup tree item

Changing a dataset rollup tree item's key(s)

Reimporting a dataset rollup tree

https://support.spiderstrategies.com/hc/en-us/articles/4408587064980
https://support.spiderstrategies.com/hc/en-us/articles/4408581928468
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Dataset rollup permission templates

The other tab on the Admin > Dataset Rollup Trees page is Permissions. This is for

creating Rollup Permission Templates, which can dramatically simplify the

management of tree-based dataset permissions.
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Each collapsible box on the Permissions tab is a rollup permission template. In this

example we have created a rollup permission template for each of three different

types of users: SARCs, Victim Advocates, and Project Managers. When you click on

a rollup tree item on the left, you can assign users and groups to the different

rollup permission templates on the right.
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The most important thing to realize here is that a rollup permission template

applies to an entire rollup tree. So, every rollup tree will have different rollup

permission templates, but you’ll see the same rollup permission templates as

you’re clicking on different items in a rollup tree. The only things that will change

between items are the users and groups that are inside of each rollup permission

template for the selected item.

In this example we’re going to click through the various items in the UIC rollup tree

and assign users and groups to the SARCs, PMs, and VAs permission templates.
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Once that’s done, we can use these permission templates to quickly assign

permissions to datasets. All you need to do is turn on advanced permissions for a

dataset and then add your permission template like you would a user or a group. In

this example there are two fields that use the UIC rollup tree, so there are two

versions of each rollup template that we can choose from.

By adding the “Victim UIC: SARCs” to the dataset, every member of the SARCs

permission template can now see records where the Victim UIC is in that SARC’s

UIC or below. You can edit this permission, just like you can with users or groups.

The only difference is that a permission template has a filter that can’t be

removed. This permanent filter shows that SARCs can see their rollup tree item

and descendants for the Victim UIC field.
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You can always add additional filters, though. For example, we could add a new

filter that also limits access to only fields with a “Restricted” value of “False”.
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Advanced: Clustering Analytics

With Datasets, Spider Impact can explore large amounts of unstructured data.

With data clustering, you can unlock powerful insights by analyzing the

relationships between your datasets’ multiple fields. Clustering creates profiles in

your data, helping you to understand the types of records most likely to show up in

your dataset.

Clustering is best explained by example. Let’s imagine that we have a dataset of

customers, and we want to discover the types of people who buy our products.

Each point on the scatter plots below represents a customer. Let’s imagine that

the X axis is age, and the Y axis is income.
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We can see that the clustering algorithm has found three clusters in the data. The

three demographics of people who buy this product are young high-income people,

middle-aged low-income people, and older middle-income people.

Looking at two dataset fields is interesting, but now let’s imagine extending these

scatter plots into a 3rd dimension by adding a Z axis. In addition to tracking age

and income, let’s say that we’re also tracking years of formal education. By seeing

points in 3-dimensional space, we could find even more interesting clusters of



USING SPIDER IMPACT 469

people. We could discover that our product is often purchased by older, higher-

income people with little formal education, or middle-aged, low-income people

with graduate degrees.

The human mind has trouble imagining data in more than 3 dimensions, but

clustering algorithms do not. The more dimensions of data that you’re able to

provide to Impact, the more powerful it becomes. Your datasets have dozens of

fields, and there are meaningful insights to be discovered.

To create a clustering field in your dataset, click the “Add” button in the Fields

table on the Edit tab.

Then choose Data Clusters from the field type.
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Next, choose which fields you want to cluster on and click the Analyze button.
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This opens a second-level dialog showing the quality of various numbers of

clusters. You can see here that 17 clusters is the best fit for our data, but that 6

clusters is almost as good.

In this situation we want to go with 6 clusters to keep things simple, so we’ll tell

Impact that we want 6 clusters instead of “Auto”.
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Finally, we’ll give each cluster a name based on its characteristics for each of the

fields we’ve chosen.

We can now use our new data clusters field just like we would any other dataset

field. The cluster that a record falls into is the cluster field’s value. In this example
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we’ve added the field to the Datasets Explore tab, but you can also use it in

Reports, Charts, and Dashboards.

Spider Impact uses the k-means++ algorithm for clustering, and each cluster’s

quality is evaluated using the Calinski Harabasz index.

https://en.wikipedia.org/wiki/K-means%2B%2B#Improved_initialization_algorithm
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Advanced: Manually Adding & Updating Records

Datasets are mostly about visualizing and exploring aggregated data. For users

with the correct permissions, however, it can also be helpful to view the details of

individual records. That’s what’s covered in this section.

There are also special circumstances when you’ll want to override dataset values

that you’ve imported, or create entirely new records that don’t exist in your data

source. It’s almost always better to change the data at the source, so overriding

values in Impact should only be used when that’s not possible.

The Records tab

On the Datasets Explore tab, we’ve applied an “Age is less than 18” filter and there

are 331 matching results.

With the correct permissions, I can click to the Records tab to see the raw data.
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Editing record values

By default, records’ values can’t be changed in datasets. When editing a field,

however, you can allow values to be overridden on the records tab.
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When one or more fields are editable and you have the correct permissions, you

can click on a record.

This shows a dialog where you can override record values. Datasets will remember

the values you enter, even after new data is imported into your dataset.
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Note that you can only make a field editable when you have a primary key defined

for your dataset. That’s because the software needs to be able to uniquely identify

the record that is being changed so that the same change will be made after you

import data again later.

Adding new records

When editing a dataset, you can allow entirely new records to be added.
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When enabled, there is an Add button on the Records tab.
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Just like editing records, added records will be preserved even after future data is

imported into the dataset.
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Forms

Overview of Forms

Forms is a section in Spider Impact that allows you to build forms that add and

update dataset records. It’s perfect for supplementing datasets with additional

fields that aren’t tracked in the system of record, but it’s also great for collecting

and managing data that isn’t stored in any system of record.

Before we get into the details of the Forms section, let’s cover why this

functionality is important. There are three types of data that Spider Impact

tracks.

Scorecards (KPIs) are updated on regular basis and are tracked forever.

Each KPI has a single value for every period.

Initiatives have a start date and an end date and usually last around 18

months. They are updated irregularly and have two values (budget and

percent complete).

Datasets track large amounts of unstructured data. Instead of tracking a

single value (KPIs) or two values (Initiatives), dataset records can have

dozens of values. For example, first name, last name, phone number, etc.

All three types of data can be updated through outside sources like spreadsheets

or database connections. They can also be manually updated directly in Spider

Impact.

KPIs and Initiatives have very specific data formats, and Spider Impact already

has great update forms for them. People can log into Spider Impact and use the

built-in forms to quickly update all KPI and Initiative values for the items that they

own.

There is, however, no universal form to update dataset values or create new

dataset records. That’s because datasets have unstructured data and can have
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dozens of fields. That’s what the new Forms section is all about. It allows people to

build the forms that they need to manually put data into Datasets.

Security and permissions

Forms inherit permissions and security from the Datasets section, allowing you to

focus on building the best form for your data. You only have permission to view,

add, or modify records in the Forms section if you have permission to do the same

thing in the Datasets section. If you only have permission to view some of the

records, you’ll only see some of the records in the Forms section.

Building forms

Creating Forms and form pages

The Forms section in Spider Impact is in the menu pane on the left.

To create a new form, click the “New Form” button and choose a dataset. Each

form is associated with a single dataset, and that’s what you’re choosing right
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now. In this example we’ll choose the Customers dataset, name the form

“Customer Management” and then click the Create button.

Now that our form is created, we’ll add the first page to the form.

We’ll call this page “Customer Details”.



USING SPIDER IMPACT 483

We now have a form for the Customers dataset with one blank page.

Adding form widgets

To add form widgets to a form page, click the “Add Widget” button. You can

choose to add one of the following widgets, all of which are explained in detail

below.
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Single Field

Checkboxes

Text

Button

Record List

We’ll choose Single Field widget, and then we’ll start adding widgets for the

Customer dataset’s fields.

https://support.spiderstrategies.com/hc/en-us/articles/10027527258260
https://support.spiderstrategies.com/hc/en-us/articles/10027643676436
https://support.spiderstrategies.com/hc/en-us/articles/10027651234324
https://support.spiderstrategies.com/hc/en-us/articles/10027550763924
https://support.spiderstrategies.com/hc/en-us/articles/10027572181268
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It looks like this when we’re done.
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We’ll also add a button widget.
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Arranging form widgets

New form widgets are added at the bottom of the page, but you can drag and

drop widgets to reorder them.

Editing form widgets

To edit a widget, just click its Edit button.

This opens the Edit Widget dialog. We’ll change the button text to “Create

Customer” and we’ll add an On-Click Action of “Save the current record”.
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This is what the button looks like when we’re done.

Widget labels and descriptions

Each type of form widget has different configuration options that are explained in

detail below. The two things that are shared by every type of widget, however, are

the Label and Description. Both are optional.
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This is what labels and descriptions look like on the form.

Note that all URLs in form widget descriptions are automatically turned into links.

In this example, we’ve added a link to an external web page in the Status field’s

description.
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When the form is being used, the link is now styled differently and is clickable.

Forms that create records

Example form

The simplest version of a form is a single page that creates a record. To use a form,

click the View tab, which is what shows by default when you first visit the forms

section. Notice how the individual form pages that you see on the Edit tab no

longer show on the View tab.
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We’ll fill out the form with the details for a new customer, and we’ll click the

“Create Customer” button. This adds a new dataset record for this customer.
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Similarities with Datasets Records tab

Manually added records will stay in your dataset, even after you import new data

with “replace all records”. This is the exact same behavior as adding a record on the

Datasets Records tab.
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The difference with the Datasets Records tab is that you have no control over

layout, no way to break data entry into multiple pages, and no way to do logic and

advanced data validation. In short, the Dataset Records tab is a simple list of

fields, and the Forms section is for building mini-apps to collect data.

All of the user permissions that apply to adding records on the Datasets Records

tab also apply to forms. For example, people can only create new records with a

form if “Allow manually adding new records” is checked on the dataset’s Edit tab.

See the Manually Adding & Updating Records article for more information.

https://support.spiderstrategies.com/hc/en-us/articles/4408588410388
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Reasons for adding records

There are two situations when adding records to datasets make sense. The first is

when you’re not in control of the system of record that your dataset is built from,

but you want to supplement it with additional records.

For example, let’s say your Employees dataset is built from a data connection to

your HR software. The HR software doesn’t track unpaid summer interns, but you

want to include the intern data with the other employees on your Spider Impact

dashboards and reports. In this situation you could create a form to manage the

summer interns. It would add additional records to the employees dataset to

supplement all of the records that are from the HR system. These new

supplementary records would stay around, even after new HR data is imported.

The more common use case for adding records to datasets is when there isn’t a

system of record and you’re starting with a blank dataset. For example, maybe you

want to send out a survey to customers, or you want to start tracking your

company’s computer hardware. In these situations you can create a dataset with

no Data Source and manually create fields.
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Another option is to choose a Spreadsheet as the Data Source and just not include

any records in the spreadsheet.

Forms that edit records

Example form

We’ll add a second page to our form called “List All Customers” and set it as the

form’s Starting Page.
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On this new blank page we’ll add a Record List widget.

Our Record List widget will have a title of “Choose a Customer to Edit”, and we’re

going to choose to show the customer fields of first name, last name, email, and

country to identify each record.
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We’re also going to have an action button in our Record List widget. Each record

will have an “Edit Customer” button that goes to the “Customer Details” page for

that record when clicked.
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Now when I go to the View tab to use the form, it lists all of the records in the

Customer dataset.
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When I click the “Edit Customer” button for one of the records, it goes to the

Customer Details page for that record.

The Country field is editable, so we’ll change that to “New Test Value” and click

Save Customer. The form goes back to the customer list and we can see this new

country value.
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When we click the Edit Customer button for this record, we can now see that its

imported value is being overridden. We can type a different value, or we can click

“Undo” to go back to the imported value.

Similarities with Datasets Records tab

If you’re editing a record that came from a data import rather than being

manually added, this new value that you entered will stay in the dataset, even

after you import new data with “replace all records” later. This is the exact same

behavior as editing a record on the Datasets Records tab.
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All of the user permissions that apply to editing records on the Datasets Records

tab also apply to forms. That means you can only override imported values in a

form if that dataset field has “Allow This Field’s Values To Be Overridden” checked

on the dataset’s Edit tab. See the Manually Adding & Updating Records article for

more information.

https://support.spiderstrategies.com/hc/en-us/articles/4408588410388
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Reasons for editing imported records

There are two reasons for editing fields in records that are imported from a

system of record. The first is when you’re not in control of the system of record

that your dataset is built from, but you want to correct its data.

For example, let’s say your Employees dataset is built from a data connection to

your HR software. If you notice that a few of the employees’ departments are

either incorrect or missing, the best approach is to fix the data in the system of

record, and then the corrected values will show up in Spider Impact. If that isn’t

possible for some reason, however, you can override the values in Impact and

they’ll stay overridden even after the next import.

The more common use case for editing an imported record, however, is adding

supplementary fields that don’t exist in the system of record. For example, let’s say

you want to track each employee’s t-shirt size, and that’s not something your HR
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software does. You can just add a T-Shirt Size field to the Employees dataset and

then enter those values using an Employees dataset form.

Forms that edit and add records

Example form

We’ve given examples above of forms that add records and forms that edit

records, but forms can also do both. Here we’re adding a “Create New Customer”

button to the form’s starting page.

This new button has two actions. First it clears fields and starts a new record.

Second, it goes to the customer details page.
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We’ll also edit the button that’s on the Customer Details page.

It’s now going to go back to the “List All Customers” page after saving the record.

We’ll also change the button’s name to simply “Save Customer” because this page
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is going to be used to both create and edit customer records.

Now when we go to the View tab, we can choose between two different types of

actions. We can click on the “Create New Customer” button, which takes us to the

“Customer Details” page to create a new record. Or, we can click on a record’s

“Edit Customer” button. This also takes us to the “Customer Details” page, but

we’ll be editing the existing record.
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Regardless of whether you’re adding or editing a record, the form will go back to

the “List All Customers” starting page when we click the “Save Customer” button.
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Single Field Widgets

Overview

The most common form widget is the Single Field widget. This allows you to enter

the value for a single field, with slightly different controls based on that field’s

data type.

You can change the field used by the widget in the widget’s Edit dialog.
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State: Editable or Text only

Most of the time you’ll want single value widgets to be Editable. If we just want to

show the value of the field for reference, however, you can change a single value

widget’s state to Text Only.
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This is what a Text Only single value widget looks like when you’re using a form.

Type: Single line or Multi line

Single value widgets will often be Single-Line, but you can also change their Type

to Multi-Line.
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This allows forms to collect paragraph-stye text.
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Values to show in Dropdown

One of the most useful features of forms is the ability to make data entry easier.

The default option for “Values to Show in Dropdown” is None.

This allows the form’s users to type in any value they want in a field that looks like

this.

If we choose “Other Record Values”, the “Allow Typing New Values” is checked by

default.
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This allows users to type in any value as before, but it also suggests existing values

in the dataset that match what they’ve typed. This can save a lot of time during

data entry.

We can also uncheck “Allow Typing New Values” when showing “Other Record

Values”.
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Users will then see a simple dropdown list of options they can choose.

When you choose to show “Specific Values”, you type in the values ahead of time.

Here we’ve entered three specific companies that users can choose from, and

“Allow Typing New Values” is unchecked.
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The form will show our three companies in a dropdown list.

You can also check “Allow Typing New Values” when showing “Specific Values”.
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This will suggest our three companies in a dropdown list, but also allow users to

type in something else.

Input Validation

Another important feature of forms single value widgets is input validation. By

default, input is optional.
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You can also set validation to Input is Required. This means users will have to enter

some value for the field.

You can set a minimum length of content. Here we’re saying users must type at

least 5 characters.

You can set a maximum length. Here we’re saying users must type 20 or fewer

characters.
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You can also set both minimum and maximum lengths.

Finally, you can choose custom form validation and enter a regular expression. In

this example we’re requiring the input to match any email address from the

domains yahoo.com, hotmail.com, and gmail.com.

There are resources across the web to help you learn how to make a regular

expression to match the text you want. We’ve found that RegExr is an online tool

that works well for building the perfect regular expression.

https://regexr.com/
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Linked fields

Single value widgets can behave a little differently when you choose a field from a

linked dataset. In this example we’re creating a single value widget for the

“Customer” field in the linked Device Sales dataset.

When your form is on the “many” side of a one-to-many linking relationship, you

can choose a single value like any other form fields. When your form is on the “one”

side of the one-to-many linking relationship, you can choose multiple values from

the linked dataset like in the example below.
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You can even use single value widgets for datasets in many-to-many linking

relationships that involve a third dataset for linking the other two.

For example, let’s say you have an Employees dataset and a Departments dataset.

If you want your employees to be able to be in multiple departments, you’d set up

an “Employee Departments” dataset with a field linking to the Employees dataset

and a field linking to the Department dataset. You could then choose multiple

departments in employee forms, and you could choose multiple employees in

department forms.
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Button Widgets

Button form widgets perform an action when you click on them.

They can have one or more of the following actions:

Save the current record

Clear fields and start a new record

Go to a form page
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Record List Widgets

Overview

Record List form widgets are added from a form page’s Add Widget menu.

A record list widget is a scrollable table with one row for every record in the

dataset. It’s sorted alphabetically by the first column.
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You can search by typing a phrase in the Find field on top. Here we’re searching for

“sherm” and the record list widget is showing the 5 records that include that

phrase in any of the fields that are showing.

Choosing columns

You can choose which fields to show columns for in the record list widget’s Edit

dialog. Here we’ve also marked the Country column as editable.
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This is what that record list widget looks like when using the form. In this example

we’ve changed Abbey Sovey's country to Armenia, and we can either Save or

Cancel the change. By making one or more columns Editable, you can make

changes to many records quickly.
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Action buttons

You can also choose to have action buttons on rows. In this example we’ve set the

action button text to Edit Customer, and we’ve set the action to go to the

Customer Details page.
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Now when we click an Edit Customer button, the form will go to the Customer

Details page for that record. It’s very common to use the record list widget like this

to choose which record you want to view or edit.

Record filters

You can change which records show in the record list widget by adding a record

filter in the widget’s Edit dialog. Here we’re choosing to only show records that

were manually added, but you can apply any of the dataset filters that are used

throughout Spider Impact.
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When we use the form we now only see the records that were manually added.

This can be very helpful when using a form to add and manage only a dataset’s

supplementary records.
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Checkboxes Widgets

The Checkboxes form widget allows you to update the values for multiple yes/no

fields at once.

Here we’re choosing four yes/no fields, and giving them labels.
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When someone uses the form, they just check the boxes to update the fields.
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Text Widgets

Text form widgets allow you to include formatted text on your forms.

This matches other rich text editing in Spider Impact, and can be used for

instructions, or even links to additional documentation.

This is the appearance of the example text at the top of the form when it’s in use.
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Other

Overview of Initiatives

The Basics

In the Scorecards section we track KPIs and strategy. You define what you want to

measure, and then you measure the same things month after month, year after

year.

Initiatives are different. They have a specific start and end date, and they often

are put into place to correct the performance of a scorecard item. For example, in

the balanced scorecard methodology, Initiatives are put in place to fix poorly

performing Objectives.

Overview Tab

The Initiatives Overview tab gives you a good feel for the overall performance of

your initiative. Spider Impact will predict whether your initiative will be on time and

under budget.
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Predicting Budget and Schedule

Spider Impact uses Earned Value Management (EVM) to predict whether your

initiatives will be on time and under budget. We've put together an entire article

on EVM to explain exactly what's going on behind the scenes.

 

https://www.spiderstrategies.com/earned-value-management/
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Changes to Key Numbers

In an effort to promote transparency, whenever an initiatives's start or end date is

edited, that information is displayed next to the new value on the overview tab.

https://www.spiderstrategies.com/earned-value-management/
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Projected End Dates in the Past

Spider Impact automatically predicts when an initiative will be finished and what

its budget will be at completion. These predictions start to fall apart, however,

when initiatives don’t get regular status updates.

It can get particularly confusing when a projected end date is in the past. This can

happen when the last status update is so long ago that the initiative has probably

ended by now. To avoid this confusion, there’s an indicator next to projected end

dates that are in the past, and when you click on it, there’s a tooltip explaining

what is happening.

Timeline Tab

The Timeline tab shows you a fully interactive Gantt chart view of the current

organization’s initiatives.
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Just like everywhere else in Spider Impact, you can expand and collapse the

initiative tree on the left. There’s also a timeline navigation bar on the bottom that

allows you to zoom and pan through time.
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If you click on any of the initiative items in the Gantt chart, you can see detailed

information about that item, like its description and the projected budget and

schedule performance.
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Strategy Maps

Overview

Strategy Maps are similar to Dashboards, except they focus only on big-picture

strategy. They have their own section in Spider Impact.

If you don't use the Balanced Scorecard methodology, there's a good change that

you'll want to disable strategy maps. We explain how to do that in the Choosing

Methodology article.

If you're unsure, we highly recommend reading our popular "What is a Balanced

Scorecard?" article to learn more.

Creating a Strategy Map

When you create a new strategy map, you have a choice between Automatic and

Blank.

https://support.spiderstrategies.com/hc/en-us/articles/360041615991
https://www.spiderstrategies.com/balanced-scorecard/
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When you choose Automatic, your new strategy map will start with your current

organization’s perspectives and objectives already on the canvas. This saves a lot

of time because all you need to do is adjust the position of your objectives and

draw arrows.



USING SPIDER IMPACT 540

Adding Widgets

Adding new widgets is exactly the same as in Dashboards too. Just click the Add

Widget button and choose an Objective or Perspective from the Scorecards

section.
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You can also add images widgets and text widgets, which are the same as on

dashboards.

Drawing Arrows

You can draw arrows between the objectives on your strategy maps. Just select

the objective where you want the arrow to start, click on the arrow button, and

drag the new arrow to another perspective.

You can even change the arrow’s thickness, opacity, and dotted style.

https://support.spiderstrategies.com/hc/en-us/articles/360041554171
https://support.spiderstrategies.com/hc/en-us/articles/360041553471
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Background Images

The Dashboard and Strategy Map Backgrounds article shows you how you can

make strategy maps even better with background images.

https://support.spiderstrategies.com/hc/en-us/articles/360053221832
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Overview of Alerts

The Basics

Spider Impact is a tool that encourages communication and collaboration. It helps

you stay up-to-date on how every area of your organization is performing. You and

your team can browse the various application sections exploring things like

dashboards and reports, but it's also incredibly helpful when Spider Impact lets

you know when there's something that needs your attention. That's where Alerts

come in.

Whenever you get an alert in Spider Impact, you'll get an email (unless you've

turned that off). You'll also see that alert on the Alerts page in the Home section.

Application-Wide Alerts

Spider Impact works best when users have to configure as little as possible. With

this in mind, there are several types of alerts that you can turn on for every user in

the software.

https://support.spiderstrategies.com/hc/en-us/articles/360041114992
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�. Red KPIs without tasks will send an alert to any KPI owner when that KPI

turns red and it doesn't have an initiative related item to correct the KPI

performance.

�. Note replied to will alert the author of any note when it gets a new reply.

�. Red KPIs upon turning red will send an alert to the KPI owner when any KPI

turns red.

�. KPI update reminders will send out alerts to KPI updaters to remind them to

update their KPI values when they havenʼt yet done so. In the example above,

Spider Impact will send out alerts 15 days before the period is over to help people

get their data in ahead of time, as well as 3 days after to remind people who have

forgotten.

�. Notify owners of parents of linked items when source is modified will send

the owners of linked scorecard items an alert when the source is edited or

moved.

Finally, you can set an email size limit (6) to prevent Spider impact from attaching

files larger than your email server can handle. Instead, your email will contain a link

that allows you to download the file from the web.
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Creating a New Alert

To create an Alert, just go to the Overview tab in the Scorecards section and click

on the Alert button in the header. In this example we don't have any alerts set for

the "Total Revenue" KPI, so we'll click the "Edit Alerts" button.

This opens the Edit Alerts dialog where we can add an alert for things like the

Score or KPI value changing, or when someone adds a Note to this scorecard item

or anything underneath it in the tree.

After you create an alert for a scorecard item, the Alert icon now turns blue. This is

similar to the bookmark icon turning blue when you have a bookmark for the item.
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In addition to being able to create alerts for Scorecard items, you can also

subscribe to be alerted when Dashboards and Briefings are published. That's

covered in the Subscribing and Publishing article.

Broadcast Alerts

You can manually send alert messages to specific people or teams. That's covered

in the Broadcast Alerts article.

Managing Alerts

You can manage all of your Alerts in the My Alerts page in the Admin section,

which also includes the ability to including create new Alerts.

https://support.spiderstrategies.com/hc/en-us/articles/360041175372
https://support.spiderstrategies.com/hc/en-us/articles/360047360091
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By default, Spider Impact will send you an email notification immediately when

you get an Alert. You can change this to send emails nightly, weekly, or never.
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Briefings

Starting a Briefing

Briefings are collections of pages from throughout Spider Impact. They allow you

to run meetings from directly within the software.

To start a briefing, go to the Briefings section, select which briefing you want, and

click Start.

All of the other controls in Spider Impact slide out and you're now in full-screen

briefing mode. You can advance through slides using the controls in the upper left

corner.
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At any point in the briefing you can click on drill-down links in your slides. This will

pause the briefing and take you to that section in Spider Impact, allowing you to

answer questions on the fly using the live data in the software. The entire time the

briefing is paused you'll see a bar on the top of the screen with links to stop or

resume the briefing on the same slide you were on before.
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Adding Briefing Slides

You can add slides to a briefing by clicking on the "Send to" button in the top menu

bar and choosing Briefing.

This opens a dialog with three things to choose:
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�. The slide name. This defaults to the name of the item you're adding.

�. A calendar period for the slide. We'll explain this more below.

�. Which briefing you want to add the slide to.

When you click Save, the slide will be added to your briefing.
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Editing Slides

You can edit an individual slides in the briefing section by choosing the slide you

want in the slide control on the top and then going to the Edit Slide tab.

The only things to edit here are the things we set up when creating the slide, its

name and calendar period.

Editing a Briefing

To edit a briefing, click the Edit Briefing button on top.
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Here you can delete slides, or drag and drop them to rearrange them.

Web Slides

When you're editing a briefing you can also add a Web Slide that shows content

from external web pages or web apps that support embedding. This is similar to

the embedded content dashboard widget, except that it's an entire briefing slide

rather than a widget on a dashboard.

https://support.spiderstrategies.com/hc/en-us/articles/360041554011
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For example, here we're showing an embedded Google Doc that has meeting

notes we want to review.
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Briefing Slide Calendar Periods

Throughout the software, Spider Impact has a calendar period selector in the

upper right corner that shows you the period for the data that you're viewing. It

works the same in dashboards as it does everywhere else. If you click the name of

the calendar period on top, you can choose to view another period.

You can choose which calendar periods to show for individual slides, however. In

this example, we're changing the Key Measure History slide to show data from 1

period earlier.
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During your briefing, you'll this this clearly labeled on the top of your briefing. You

can still change the overall calendar period selector, of course, but it's also clear

both the overall change you're making and how it will affect your slide.

Similarly, you can choose to show a specific calendar period.

And this is what it looks like during a briefing.
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Equations

Equations are great for combining values from other places in Spider Impact.

They're used throughout the software for things like calculated KPI values, building

dataset fields, and adding advanced filters to reports, charts, and dashboards.

Referencing Other Values

There are several types of values you can reference in equations. KPI values can

only be used in calculated KPI equations. They're referenced by scorecard item ID

like this:

M(123)

Scorecard item scores are the same kind of thing. They're only used in KPI

equations, and they're referenced by scorecard item ID like this:

S(123)
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Similarly, initiative values are also only used in calculated KPI equations. They're

referenced by initiative ID and field like this:

I(BR, 123)
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Dataset values are different. They can only be used in calculated dataset fields

and filters. They're referenced by field name like this:

[Incident Date]

This is just the start of what you can do with references to other values. Please see

the the Calculated KPIs and Dataset Equations: Fields and Filters articles for more

information.

If/Else

The syntax for an IF statement is:

if(condition, truevalue, falsevalue)

Here's an example equation. "If the value for KPI #123 is 5, this equation returns

10. Otherwise return 0."

if(M(123) == 5, 10, 0)

https://support.spiderstrategies.com/hc/en-us/articles/360041117552
https://support.spiderstrategies.com/hc/en-us/articles/4408581918740
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Note that you'll need to use the double equal operator == when checking for an

equal value, as explained below.

You can also string together multiple IF statements to create an IF/ELSE chain like

this. "If the value for KPI #123 is 5, return 10. Else if the value for KPI #123 is 4,

return 100. Else return 0."

if(M(123) == 5, 10, if( M(123) == 4, 100, 0))

Text (String) Manipulation

You can concatenate text together with the + symbol, and you can reference

specific text in quotes. For example, here's how you'd create a new text string that

is the first name field, then a space, then the last name field:

[First Name] + " " + [Last Name]

You can also do text manipulation on numbers if you first tell the software to treat

the number like text. In this example, we want to get the first four characters of a

number. To do this, we first have to concatenate the number with blank text to

turn it into text.

left(""+[myNumber],4)

Yes/No KPI Values

Yes/No values can be referenced as booleans (true/false) or as numbers (1/0).

In this example, we're building an equation for a number KPI, and we're using the

value from a Yes/No KPI in that equation. "If the value for KPI #123 is yes, return 5.

Else return 20"
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if(M(123), 5, 20)

It goes the other way too. In this example, we're building an equation for a Yes/No

KPI, and we're using the value from a number KPI in that equation. "If the value for

KPI #456 is greater than 7 return true. Else return false"

if(M(456) > 7, true, false)

This is the same as:

if(M(456) > 7, 1, 0)

Note that in the example above we're using 1 and 0, but any non-zero number will

evaluate to Yes in a Yes/No KPI's equation.

Because Yes/No KPI values are treated as 1 and 0, you can even use them in

functions just like any other KPI value. In this example we're building an equation

for a calculated Yes/No KPI. This equation looks at three other Yes/No KPIs. If

most of them are yes, it returns yes. If most are no, it returns no.

if(avg(M(123), M(456), M(789)) > 0.5, true, false)

Dates

You can adjust a date by a certain number of days using the plus and minus

operators (+ and -). For example, this means 5 days after the incident date:

[Incident Date] + 5

and this means 5 days before the incident date:
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[Incident Date] - 5

You can adjust a date by years, months, or days by using the add() and subtract()

functions. For example, this would be three months after the incident date.

add([Incident Date], 3, "months")

and this would be one year before the incident date:

subtract([Incident Date], 1, "years")

You can reference specific attributes of a date by using the month(), year(),

dayofweek(), dayofmonth(), and dayofyear() functions. Months are returned as 1

(for January) - 12 (for December) and days of the week return 1 (for Sunday) - 7

(for Saturday). For example, if the incident rate for a record were on July 1st, 2022,

this would return a value of 7:

month([Incident Date])

And this would return 184:

dayofyear([Incident Date])

To reference the current date, use the today() function:

today()
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You can parse dates from strings that are in ISO-8601 format with the date()

function. For example, this evaluates to December 31st, 2018:

date(2018-12-31)

If the date string isn't in ISO-8601, you can tell Impact how to parse the dates

with Y, M, and D characters. If mydate were formatted like 3/15/2020 you'd use:

date(mydate, 'm/d/y')

If mydate were formatted like 15-Mar-20 you'd use:

date(mydate, 'd-m-y')

If mydate were formatted like March 15, 2020 you'd use:

date(mydate, 'm d, y')

Like all functions in equations, you can combine multiple date functions together.

For example, here's how to determine the number of days in the current year:

dayofyear(year(today())+"-12-31")

Operators

Spider Impact supports a wide variety of operators in equations.

Operator Symbol

Addition, Subtraction +, -
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Multiplication *

Division /

Not Equal, Equal !=, ==

Power ^

Boolean Not !

Unary Plus, Unary Minus +x, -x

Modulus (remainder) %

Less Than, Greater Than <, >

Less or Equal, More or Equal <=, >=

Boolean & &&

Boolean Or ||

Functions

This is a comprehensive list of all functions available in Spider Impact. Please see

the Calculated KPIs article for more information and examples about using the

most popular functions.

Spider Impact Functions Format  Notes

Empty (blank, null) value check isblank(kpi_id)  

N/A (not applicable) value check isna(kpi_id)
KPIs

only

KPI's own value M()
KPIs

only

https://support.spiderstrategies.com/hc/en-us/articles/360041117552
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KPI's own threshold T(field) KPIs

only

KPI's own value in another period

(three earlier)
M(-3p)

KPIs

only

KPI's own threshold in another

period
T(field, -3p)

KPIs

only

another KPI value M(kpi_id)
KPIs

only

another KPI threshold T(kpi_id, field)
KPIs

only

another KPI value in another period M(kpi_id, -3p)
KPIs

only

another KPI threshold in another

period
T(kpi_id, field, -3p)

KPIs

only

another scorecard item score S(item_id)
KPIs

only

another scorecard item score in

another period
S(item_id, -3p)

KPIs

only

initiative item's value (see above for

list of fields)
I(field, initiative_id)

KPIs

only

To-date aggregation (Sum or

Average)

TD(calendar, kpi_id, field,

aggregation)

KPIs

only
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Text (String)

Functions

Format Notes

Concatenation mystring1 + mystring2  

Left left(mystring, 4) first 4 characters

Right right(mystring, 4) last 4 characters

Middle mid(mystring, 2, 3)
3-character string starting at the

second character

Substring substr(mystring, 2, 3)
Starting at the second character

and ending at the third

Substring substr(mystring, 2)
Everything starting at the second

character

Lower Case lower(mystring)  

Upper Case upper(mystring)  

Length len(mystring)  

Trim

Whitespace
trim(mystring)  

Contains
contains("something",

"s")
Returns true, case sensitive

Does not

Contain

!contains("something",

"s")
Returns false, case sensitive

 

Date Functions Format
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Day Addition, Day Subtraction +, -

Add months, days, or years add(mydate, 3, "months")

Subtract months, days, or years subtract(mydate, 2, "years")

Month [1 (January) to 12 (December)] month(mydate)

Year year(mydate)

Day of the week [1 (Sunday) to 7 (Saturday)] dayofweek(mydate)

Day of the month [1 to 31] dayofmonth(mydate)

Day of the year [1 to 365] dayofyear(mydate)

Current date today()

Date parse (ISO-8601) date(mydate)

Date parse (example, March 15, 2020) date(mydate, 'm d, y')

 

Statistical Functions Format

Average (ignores blanks) avg(x1, x2, x3, …)

Sum sum(x1, x2, x3, …)

Minimum (ignores blanks) min(x1, x2, x3, …)

Maximum (ignores blanks) max(x1, x2, x3, …)
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Rounding Functions Format

Round (round up when tied) round(x), round(x, decimal_places)

Round (round to even value when tied) rint(x), rint(x, decimal_places)

Floor floor(x)

Ceiling ceil(x)

 

Other Common Functions Format

Str (convert number to a string) str(x)

Absolute Value / Magnitude abs(x)

Random Number (between 0 and 1) rand()

Modulus (remainder when x is divided by y) mod(x,y)

Square Root sqrt(x)

Binomial coefficients binom(n, i)

Signum (-1,0,1 depending on sign of argument) signum(x)

 

Trigonometric Functions Format

Sine sin(x)

Cosine cos(x)
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Tangent tan(x)

Arc Sine asin(x)

Arc Cosine acos(x)

Arc Tangent atan(x)

Arc Tan with 2 parameters atan2(y, x)

Secant sec(x)

Cosecant cosec(x)

Co-tangent cot(x)

Hyperbolic Sine sinh(x)

Hyperbolic Cosine cosh(x)

Hyperbolic Tangent tanh(x)

Inverse Hyperbolic Sine asinh(x)

Inverse Hyperbolic Cosine acosh(x)

Inverse Hyperbolic Tangent atanh(x)

 

Log and Exponential Format

Natural Logarithm ln(x)

Logarithm base 10 log(x)

Logarithm base 2 lg(x)
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Exponential (e^x) exp(x)

Power pow(x)

Always use "." for decimal and "," for functions

Many European languages use the "," character for the decimal separator and "."

for the thousands separator. For everywhere except equations, Spider Impact

looks at your browser's language settings and correctly displays numbers based on

your region.

Equations in Spider Impact are different. Regardless of your language settings,

you'll need to use "." for decimal separators and "," for separating function

arguments. This is common in programming languages and allows you to build

advanced equations in Spider Impact that are used across regions.
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Organizations and Templates

Rolling Up KPIs Across Organizations

Overview

You can use templated organizations to create an organization tree that tracks

the same KPIs for each organization. With rollup KPIs, you only have to update the

KPIs at the bottom of the tree. The software will then automatically roll the KPI

values up the tree to create totals for the KPIs in the higher organizations.

Building Rollup KPIs

KPI values can be updated in a variety of ways. They can be updated manually,

they can be calculated, or they can be part of template rollups. When you select

the "Template Rollup" update type, Spider Impact automatically aggregates the

KPI values from children organizations that are based on the same organization

template.

https://support.spiderstrategies.com/hc/en-us/articles/360041176512
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To set up these automated rollup KPIs, first create an organization that you want

to use as your template. Any KPIs in the template that you want to be

automatically calculated should have the update type of "Template Rollup." You

also can change the Template Rollup Equation, which determines how the KPI

values will be aggregated together as they’re rolled up the organization tree.

Once you’ve created your organization with rollup KPIs, the next step is to create

templated copies of that organization in a tree structure. In this example, “Rollup

Template Example” is the template organization we built, and the six

organizations underneath it are templated copies.



USING SPIDER IMPACT 574

Finally, update the KPIs in the organizations at the bottom of the organization

tree. The KPIs in the organizations higher up the tree will automatically have

calculated values based on the KPIs in lower organizations.

For example, when we go to the highest-level organization and hover over the

“product revenue” actual value, we can see that its actual value is being

automatically calculated.
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We can click on this value to see more information about where the data actually

comes from.
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By hovering over the different parts of the equation, we can see that this highest-

level KPI is the sum of the KPIs in the four organizations at the bottom of the tree.

If you remember, though, the rollup tree is three levels deep. Why is the automatic

template rollup equation skipping the middle level of the tree and going directly to

the lowest level?

That’s on purpose. For “sum” template rollup equations, the results would be the

same either way, and it makes things a little simpler to show where the data is

really coming from. For “average” template rollup equations, skipping the middle

levels avoids some messy math problems that you’d get by taking averages of

averages.
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Separate Tree and Time Aggregations

Rollup KPIs are aggregated in two different ways. The template rollup equation is

used when aggregating values up the organization tree. The aggregation type is

used when aggregating smaller calendar periods into larger calendar periods, like

turning monthly values into a yearly value.

An example will make it easier to understand the need for separate ways to

aggregate. Let’s say we run a large waste disposal company and we’d like to

reduce the number of trucks that are out of service due to them being repaired.

We have dozens of trucks in each city, and thousands of trucks across each region,

so we realize that there will always be some that are broken. We just want to

minimize that number over time.

We’ll create a KPI called “Number of trucks out of service” that will track the

number of broken trucks. We’ll also make it a rollup KPI and build out a multi-level

templated organization structure that matches our company.

So, we have a rollup KPI that takes the number of broken trucks and aggregates

them up the org tree. What should the template rollup equation be? Sum makes

the most sense, because the number of broken trucks at the regional level would

be the sum of all broken trucks in that region’s cities.
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Now, how do we aggregate our broken truck KPIs over time? That’s a little trickier.

Let’s say each of the cities update their KPI with a new value every week. What

should each city’s KPI value be when you look at it yearly? It doesn’t really make

sense to add all of the weekly values together. That would mean that the more

often you measure the KPI, the higher the yearly value will be.

For this KPI, an average aggregation type makes the most sense. If you measure

the number of broken trucks every week, and average those numbers over a year,

you can good a good feel for how many trucks are out of service most of the time.

With this KPI structure, you could go to a region in the organization tree, change

the application calendar to monthly, and you could see the average number of

broken trucks in that region for that month. Each city updates their broken truck

KPI every week, and the software takes care of the rest.

And that’s why there are two different ways to aggregate rollup KPIs. There are

situations like our example above where the KPI value should be summed up the

rollup tree but averaged over time.

Rollup KPIs Without Templates

The vast majority of the time, rollup KPIs are only used in templated organizations.

You may notice, however, that the "Template Rollup" update type shows up as an

option for KPIs that aren't part of a template. That's because in some rare

situations, you may want to use rollup KPIs with non-templated organizations.

The requirements for non-template structure are the same as templated. The

organizations still need to be in a tree, and the scorecard structures that you're

using for rollup KPIs need to have the same names. The only difference is that the

software is matching the KPIs based on their names and their ancestor's names

rather than the template they're using.
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This is so uncommon, however, that we decided to call the update type "Template

Rollup," even though the organizations don't technically have to share a template.
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Templated Organizations from Datasets

Templated organizations based on dataset values

Organization templates allow you to quickly roll out similar scorecard structures to

multiple organizations. When your organizations have dataset KPIs, this process is

even easier.

In this example we have an organization called “Templated Sales Example” that

has two KPIs. “Number of Sales” tracks the total number of sales over time, and

“Sales $” tracks the value of sales over time. As you can see here, there were

$797,000 in sales in July 2021.

We’re going to click on the organization name on top to expand the organization

pane, and then put the organization tree into edit mode by clicking on the Edit

button on the bottom. Then we’ll click on our “Templated Sales Example”

organization and choose “Copy as Template”.
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This opens the new template dialog. The first copy option would create a single

copy of our organization. The middle option does the same thing, but would also

copy any descendant organizations that we create later. We’re going to choose the

third option to “Create a copy of ‘Templated sales example’ for every value of a

dataset field”.
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Our two KPIs are created from the Device Sales dataset, so we’ll choose that here.

We’ll also choose the Sales Employee field. If we decide to not add any filters,

Impact will create a separate organization for every sales employee.

Finally, we’re going to add a filter to only include records where the sales

department is Retail. When you apply a filter, it restricts the records, which in turn

can restrict the number of organizations that are created. So, rather than creating

an organization for every sales employee, we’re going to create an organization for

every *retail* sales employee.

The one exception with filters is rollup trees. If the filter is for the same rollup tree

field as the field you’re using for the template, the filter restricts the organizations

you create, but the descendant totals are always used for the KPIs.

The last step in the wizard is to optionally add prefixes or suffixes to the names of

templated items. We’ll just click Copy.
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After a few seconds, new organizations start to appear in the organization tree

underneath our template. There are 6 organizations, one for every retail employee.
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When we click on Delphine Calmes, we can see that the KPIs now show data

specific to that employee. Delphine had $53,000 in sales in July 2021.

Just like with all organization templates in Impact, you can create additional KPIs

in the template and they’ll be automatically copied to the templated copies. You

can also create KPIs in the templated copy organizations to track things for only

that organization.
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Exporting and Sharing

Exporting KPI Value Import File

You can import KPI values in multiple places throughout Spider Impact. Simple

imports require a very specific data format for your KPI values, and you can create

these files to match your existing scorecards.

Just click the "Send To" button in the menu bar on the top right, and select “KPI

Value Import File.” This is useful when exporting and importing KPI values, or for

creating blank import files to be filled in with KPI values manually.

This will open a dialog and the first step is choosing which organizations you want

to include in your file. It adds the current organization by default, so if that’s all you

want, just click next.

https://support.spiderstrategies.com/hc/en-us/articles/360050097311
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The next step has more options about what to include in the import file you’re

creating. You’ll need to choose a start and end date, and you can choose whether

to include calculated values or not. Most importantly, you’ll want to choose which

format you want your data to be in.

“Data in Columns” has one row for every KPI, with separate columns for each date.

If you’re going to be manually editing the spreadsheet, this is a great option to

choose. “Data in rows” puts each KPI value in a row, which means each KPI spans

multiple rows. It’s harder for people to edit, but it has the added benefit of

including thresholds. This is a great option for exporting data that isn’t going to be

edited before it’s imported again.

Both options are readable by Spider Impact when you're importing the scorecard.

In this example we’ll choose “Dates in Columns.”



USING SPIDER IMPACT 587

The final step is a preview of your file before you download it. This is to make sure

you’ve set things up properly.
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When you click the “Download Import File” button, it will save a spreadsheet that

matches the preview. If you choose “Data in Columns” and have KPIs that use

different calendars, your spreadsheet will have one worksheet for every calendar.
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Exporting Scorecard Import File

You can import scorecard items in the Scorecards section. These imports require a

very specific data format, and you can create these files to match your existing

scorecards.

Just click the "Send To" button in the menu bar on the top right, and select

“Scorecard Import File.”

This exports a spreadsheet of your entire scorecard that is in the format required

for scorecard item imports.

https://support.spiderstrategies.com/hc/en-us/articles/360041132492
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Application Administration

Choosing Methodology

Choosing Methodology Language

Spider Impact works great with any performance management methodology. To

make getting started even easier, you can choose between popular methodology

language right in the app

There’s a new Methodology section in Application Administration where you can

choose what language to use in Spider Impact. For scorecard item names you can

choose between balanced scorecard language like Measure, Perspective, and

Theme. Another option is KPI language like KPI, Key Performance Area, and

Generic Items.

As always, you can further customize any language in the software with a custom

language file. Please let us know if you need help setting that up.

Enabling and Disabling Strategy Maps

Strategy Maps are similar to Dashboards, but they’re solely focused on showing

your big-picture strategy. The Strategy Maps section is now available to all Spider

Impact customers and can be enabled in Application Administration.
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Users

Overview

Users are created and managed on the Admin > Users screen.

Adding Users

You can add a new user using the + button.
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You can then enter a username, email address, first and last name, and password. 

You have the option of whether or not the user must change their password on

initial login, and can assign the user as a member or admin of a group.
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Importing Users

Rather than manually adding users one at a time, administrators can import

multiple users at a time via spreadsheet. To start, just click on the "Import"

button.

This brings up a dialog where you can upload your spreadsheet. It also has

instructions on data format and an example file to download.  You can build up a

list of users to include their username, email address, first and last name, and

password (the middle name, group_key, and title columns are optional).  Once the

file has been developed, you can import the users using the Browse button.
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Before you run the import, you can preview your data and you will be alerted to

any invalid fields.  For existing users, specifying a password will reset it and force

them to change it on their next login.
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Searching Specific User Fields

Administrators can now choose which fields to search against when editing users.

It defaults to Everything to match the previous functionality.
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Permissions

User permissions are defined within groups.

https://support.spiderstrategies.com/hc/en-us/articles/360041554491
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Groups

Overview

Groups are created and managed on the Admin > Groups & Permissions screen. 

Groups determine permissions within Spider Impact.  Permissions applied to a

group are granted to all of its members.

Creating Groups

You can create a new group using the + Add button.
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You can then enter a name for the group, select a group type, apply Advanced and

Organization permissions, add group members and group admins.

Group Types

You can pick from four different group types.  Once you pick a group type,

permissions for the group can be set under Advanced.

Power Users

Power Users have the most permissions available to them.  Administrators are

typically set as power users and granted all permissions.
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Update Users

Update Users can own items, set bookmarks, update KPI actual values and

thresholds, add notes, modify files, set alerts and create tasks.
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Interactive Users

Interactive Users can set bookmarks, add notes and set alerts.  Company

executives are typically set as interactive users and granted the ability to see all

organizations.  They can review performance and comment on their findings.
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View Only

View Only users can only view things in Spider Impact.

Copying Groups

You can copy a group by selecting the group and selecting the Copy button.
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You can then rename the group, and choose whether or not to copy the original

group's members, admins, and organization permissions (Advanced permissions

automatically carry-over).
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Deleting Groups

You can delete a group by selecting the group and clicking the Delete button.

By Group vs. By Organization

You can edit a group by group or organization - the default view is "By Group".
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The “By Organization” view allows administrators to see all groups who can view a

particular organization. The idea here is that you can choose an organization and

then see exactly who has permission to view it.

The top window on the right shows all of the groups that have “Direct

Permissions” to the selected organization.

Administrators can also expand the “Cascading Permissions” box to see the groups

who can see the selected organization based on permission to a higher-level
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organization.

Similarly, administrators can also expand the “Can View All Organizations” box to

see who can view the organization based on global permissions.
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Editing Scoring Types

This article covers how to choose and edit the KPI scoring types that are available

in Spider Impact. For information about actually using these KPI scoring types, see

the Using KPI Scoring Types article. For information on changing how scores are

displayed, see the App Administration: Scoring article.

Choosing Standard Scoring Types

The Scoring Types page in the Administration section allows you to choose which

scoring types are available for both KPIs and non-KPIs. This allows system

administrators to show fewer scoring type options to users. You can order scoring

types via drag and drop, and you can add new scoring types by clicking the “Add

Scoring Type” button.

Here we’re adding the standard “4 Color Scored Middle” scoring type, and when we

select it, we can see a preview of that scoring type’s thresholds and scores.

https://support.spiderstrategies.com/hc/en-us/articles/360041554151
https://support.spiderstrategies.com/hc/en-us/articles/360041729131
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Custom Number Scoring Types

You can add custom scoring types to match any unconventional colors or

thresholds you may have in your organization. Custom Number scoring types allow

you to choose the number of thresholds, what they’re called, what their scores are,

and the colors between them.
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Here we’ve added a fourth threshold and are choosing to make the KPI blue

whenever the score is more than 9.
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You can also create Stabilize Number custom scoring types. They’re the same as

Number custom scoring types except the highest score is in the middle.

Custom Text Scoring Types

You can create custom text scoring types where you create a predefined list of text

KPI values that a user can choose from. In this example we’ve chosen Unscored

Text with the following options:

Failed

Meets Expectations

Exceeds Expectations
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When you choose Scored Text each KPI value also has a color and a score.
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App Administration: Scoring

This article is about choosing the mechanics of scorecard scoring, including the

scoring scale and how to treat missing data. For information about choosing

which scoring types will appear as options for your KPIs, see the Editing Scoring

Types article. For information about actually using these KPI scoring types, see the

Using KPI Scoring Types article.

Scoring Scale

There are several configuration options that allow you to fully customize the scores

that are assigned to scorecard items.

�. By default, scores are shown as numbers, but you can change them to be

percentages. This is what that looks like in the software. 

https://support.spiderstrategies.com/hc/en-us/articles/10022397290260
https://support.spiderstrategies.com/hc/en-us/articles/360041554151
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�. By default, scores are 0 to 10, but you can change these to any minimum

and maximum value. For example, this is what 0 to 5 scoring looks like. 

�. You can choose to allow your scores to go outside of the scoring range.

When a KPI value is significantly above or below the goal, it can get a score

outside of the normal range. In this example a value of 60% would be a

perfect score of 10, but because its value is 60.5%, its score is 10.8.
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Missing Data

There are several scoring configuration options that deal with how to treat missing

data in various forms.

�. "Show N/A Option" is on by default, and allows choosing a value of N/A for

KPIs instead of actually entering a number. This means Not Applicable and is

like entering a blank value. 

�. By default, missing KPI values in equations are treated as blank, but they

can be treated as 0, N/A, or they can immediately make the entire equation
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blank.

�. Dividing by 0 in an equation usually makes the result blank, but you can

optionally make it evaluate to 0.

�. “Ignore Gray Scorecard Items For Tree Rollup” is for missing values when

rolling scores up a scorecard tree. By default, missing values are ignored,

which means that a parent will have a score if at least one of its children has

a score. 

When “Ignore Gray Scorecard Items For Tree Rollup” is off, a single missing
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KPI value will cause everything in the tree above it to have no score. 

�. “Ignore Periods Without Values For Time Aggregation” is for missing values

over time. By default missing values are ignored, so a larger period is scored

even when not all of the smaller periods are complete. In this example the

Total Gross Profit KPI does not yet have a value for December 2021. 

When you change the calendar to Quarter 4, 2021, the Total Gross Profit KPI

has a score for that quarter, even though one of the months in the quarter

doesn’t have a value. 
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When “Ignore Periods Without Values For Time Aggregation” is off, Quarter

4, 2021 now has a blank score because not all of the months in the quarter

have values. 

Other Scoring Configuration
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�. This sets the scoring type for all non-KPI scorecard items. You can choose

from the enabled scoring types in Administration > Scoring Types.

�. Although it’s not a popular configuration option, you can set “Scores Visible”

to “no” in Application Administration. This will prevent scores from

appearing in most places. 

There are still a few places where scoring cannot be avoided, though, like

graphing the performance of a non-KPI scorecard item.

https://support.spiderstrategies.com/hc/en-us/articles/10022397290260
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�. Forward Effect Scoring is off by default and should not be used by most

customers. Most people who enable this decide to disable it later. Forward

effect scoring is best explained with an example. By default, a yearly KPI

viewed in monthly mode is gray until the very end of the year when it's

updated with that year's value. When forward effect scoring is enabled, the

KPI would use the previous year's color and score when viewed monthly so it

isn't gray. In practice this is very confusing to most users, and is only

supported for legacy customers.


